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Operating Instructions
Software

Model No.

English

Before operating this software, please read these instructions completely and keep these operating instructions for future reference.

(For Document Management System, Printer and Class 2 Fax Modem)
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The following trademarks and registered trademarks are used throughout this manual: 

Microsoft, MS-DOS, Windows and Windows NT are registered trademarks of Microsoft 
Corporation in the USA and other countries.
i386, i486 and Pentium are trademarks of Intel Corporation.
Centronics is a registered trademark of Centronics Data Computer Corporation.
TrueType is a registered trademark of Apple Computer, Inc.
All other trademarks identified herein are the property of their respective owners.

Copyright c 2000-2001 by Matsushita Graphic Communication Systems, Inc.
All rights reserved. Unauthorized copying and distribution is a violation of law.
Published in Japan.

The contents of these Operating Instructions are subject to change without notice.
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Before Use

Precautions

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to
radio communications.  However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the interference by
one of the following measures:

1. Reorient or relocate the receiving antenna.
2. Relocate fax machine with respect to receiver or other equipment.
3. Connect fax machine into outlet on a circuit different from that to which the receiver is connected.
4. Consult the dealer or an experienced radio/TV technician for help.

Warning: To assure continued compliance, use only shielded interface cable when connecting the facsimile
machine parallel interface port to host computer. Also, any changes or modifications not expressly approved
by the party responsible for compliance could void the user's authority to operate this equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1)
This device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

• You need to read the software license agreement before setting up the Printer Driver.
• You need to read the following precautions which is described in the Machine’s Operating Instructions.

1. Installation
2. Ventilation
3. Handling
4. Toner and Paper
5. For your safety

For User in USA

Responsible Party: Matsushita Electric Corporation of America
One Panasonic Way, Secaucus, NJ 07094 

Technical Support: Panasonic Document Imaging Company/Technical Support Department
Two Panasonic Way, Secaucus, NJ 07094
1-800-225-5329
Email: consumerproducts@panasonic.com
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External View and Control Panel

Q Q Q Q DP-135/150

External View

Parallel interface connector
    Connect to the PC

Parallel interface cable
    (A cable does not come with the unit.)  Use a cable of IEEE 

1284 specifications, with a maximum length of 20 ft (6m).  
Consult a service provider for details.

Power Switch
    Usually set to (l) position.
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External View

Q Q Q Q DP-1810/2010

Parallel interface connector
   Connect to the PC

Parallel interface cable
    (A cable does not come with the unit.)  Use a cable of IEEE 

1284 specifications, with a maximum length of 20 ft (6m).  
Consult a service provider for details.

Power Switch
    Usually set to (l) position.
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External View
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Q Q Q Q DP-2000/2500/3000

Parallel interface connector
    Connect to the PC

Parallel interface cable
    (A cable does not come with the unit.)  Use a cable of IEEE 

1284 specifications, with a maximum length of 20 ft (6m).  
Consult a service provider for details.

Power Switch
    Usually set to (l) position.
9
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Q Q Q Q DP-135P/150P/150PA

Q Q Q Q DP-135FP/150FP/150FX

Control Panel

No. Name Function
ON LINE LED Lit : Data is being received from the PC.

Off : Printer is in standby.

Paper Misfeed/
Add Paper LED

Paper is misfed.
Paper is empty.

3 Digits LED
(DP-135P/150P)
Message Display
(DP-135FP/150FP/
150FX)

Displays Printer Condition
If an error code/message is shown, please refer to the “Troubleshooting”
section for a corrective action.
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Control Panel
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Q Q Q Q DP-1810P

Q Q Q Q DP-1810F

Q Q Q Q DP-2010E

No. Name Function
ON LINE LED Lit : Printer is operational online 

Off : Printer is offline

STOP key Used to cancel the print job.

1

2
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Control Panel

Q Q Q Q DP-2500/3000

No. Name Function
ON LINE Switch the printer from off-line status to on-line status.

OFF LINE Switch the printer to off-line status. (The printer cannot be set off line
when the data LED is blinking.

SECURITY PRINT Used to print or delete the security print data.

CANCEL Used to cancel the print job.

ON LINE LED Lit : Printer is operational online 
Off : Printer is offline

DATA LED Lit : Data is being received from the PC, or printing is under operation.
Off : Printer is in standby or printing has been completed.
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Control Panel
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Q Q Q Q DP-2000

No. Name Function
ON LINE LED Lit : Printer is operational online 

Off : Printer is offline

DATA LED Lit : Data is being received from the PC, or printing is under operation.
Off : Printer is in standby or printing has been completed.

STOP key Used to cancel the print job.
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Printer Section

Installing the  Printer Driver

Windows 95/98/Me/NT/2000/XP

1 Insert the Panasonic Document Management
System CD-ROM.

2 Click on the desired language.

3 Click on the  button.

4 Click Printer Driver.

Note: The Fax Gateway and Firmware Update 
Utility is only available on U.S.A. and 
Canada only.

Next
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Windows 95/98/Me/NT/2000/XP
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5 Click Install Printer Driver.

6 Select your machine's model(s) and click the

 button.

7 Click the  button if you would like

to change your current default printer to the
one that you are installing.

8 Select your new default printer from the New

Printer List and click the  button.

Next

Yes

Next

Continued on the next page...
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Installing the Printer Driver
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Windows 95/98/Me/NT/2000/XP
The Panasonic/Panafax Printer Driver is installed, and the Panasonic/Panafax Printer icon(s) are added to
the Printer folder.

If you are installing the Printer Driver for network printing, please contact your network administrator for the
IP Address of the machine and proceed to the next section to install the LPR Monitor service after your
computer has rebooted.

NOTE 1. When installing on Windows NT 4.0 and Windows 2000/XP, log onto the computer/network
with an account rights of Administrator.

9 The required files are copied.

10 When the setup process is completed, a
message is displayed prompting you to restart
your computer.

Click the  button to restart your

computer.

Finish
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Installing the LPR (Line Printer Remote) Monitor

Windows 95/98/Me

1 Insert the Panasonic Document Management
System CD-ROM.

2 Click on the desired language.

3 Click on the  button.

4 Click Printer Driver.

Note: The Fax Gateway and Firmware Update Utility is 
only available on U.S.A. and Canada only.

5 Click Install LPR Monitor.

Next

Continued on the next page...
17



Installing the LPR (Line Printer Remote) Monitor
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Windows 95/98/Me
6 The Setup dialog box appears.

Click on the  button.

7 The setup program copies the necessary files onto
your Hard Disk.
When the setup process is completed, a message
is displayed prompting you to restart your
computer.
It is recommended that you restart your computer
now so that the LPR Monitor is started.

Click on the  button.

8 After your computer is rebooted, click the Start
button, point to Settings, and then click Printers.

The Printers folder appears.

Right-click on your desired printer (Ex. Panasonic
DP-3000) and select Properties from the pop-up
menu.

Next

OK
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Windows 95/98/Me
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9 The printer properties dialog box appears.

The following step is to Register the LPR Port for
network printing.

Before proceeding, ensure that the Printer is
installed, connected to the Network, is turned ON
and operating properly.

10 Select the Details tab and click on the

 button.

11 The Add Port dialog box appears. Click the Other
radio button, and select HLPRMON from "Click the
type of port you want to add:" and click on the

 button.

Add Port...

OK

Continued on the next page...
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Installing the LPR (Line Printer Remote) Monitor
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Windows 95/98/Me
NOTE 1. The LPR Monitor is necessary to install your PC if printing a data via LAN.

12 The LPR Port Name dialog box appears.

Type the IP Address of the machine and "lp"as the
queue name separated by a ":"

Ex: 10.74.229.105:lp

Click on the  button. If an error occurs

because the queue name was already used for the
same IP Address, select a different unique name
such as "lpr".

13 The screen reverts to the Printer’s Properties.

Check that the "Print to the following port:" was
changed as entered, and click on the Apply button

first and then on the  button.

The printer properties dialog box is closed and you
have now configured the printer as a network printer.

OK

OK
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Log in using an account with the administrator's right.

Windows NT 4.0

1 Click on the Start button, point to Settings, and click
Control Panel.

The Control Panel window appears.

Double-click on the Network applet.

The Network dialog box appears.

2 Click on the Services tab.

Verify whether the LPR Service is already installed.
(Indicated by Microsoft TCP/IP Printing shown in the
Network Services list.)

If it is already installed, skip over to Step 7. Otherwise
continue installing the LPR Service.

3 Click on the  button to display the

Select Network Service dialog box, then select
Microsoft TCP/IP Printing.

Click on the  button.

Add...

OK
21Continued on the next page...



Installing the LPR (Line Printer Remote) Monitor

22

Windows NT 4.0
4 The Windows NT Setup dialog box appears.

Insert the Windows NT 4.0 CD-ROM, and type
D:\i386 (where "D:" is your CD-ROM drive).

Click on the  button.

5 After the files are copied into your Hard Drive, the
display returns to the Network dialog box. Confirm
that the Microsoft TCP/IP Printing service was added
to Network Services list.

Click on the  button.

Note: Delete and Reinstall the Microsoft TCP/IP
Printing if an error occurs, and the Microsoft
TCP/IP Printing is displayed in the Network
Services list, but, the OK button does not
change into a Close button.

6 The Network Settings Change dialog box is

displayed, click on the  button to confirm

whether to restart your computer now.

You have now completed the LPR Service
installation.

7 After your computer is rebooted, click the Start
button, point to Settings, and then click Printers.

The Printers folder appears.

Right-click on your desired printer (Ex. Panasonic
DP-3000) and select Properties from the pop-up
menu.

Continue

Close

Yes
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Windows NT 4.0
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8 The following step is to Register the LPR Port for
network printing.

Before proceeding, ensure that the Printer is
installed, connected to the Network, is turned ON
and operating properly.

Select the Ports Tab and click on the

 button.

9 The Printer Ports dialog box appears.

Select LPR Port and click the 

button.

10 The Add LPR compatible printer dialog box
appears.

Enter the IP Address of the Printer in the upper field,
and "lp" for the print queue name in the lower field.

Click on the  button.

(Please wait while the wizard verifies the IP Address
and connectivity to the Network)

Add Port...

New Port

OK

Continued on the next page...
23



Installing the LPR (Line Printer Remote) Monitor
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Windows NT 4.0
11 The Printer Ports dialog box appears.

Click on the  button.

12 Select the printer port and click the 

button.

The printer properties dialog box is closed and you
have now configured the printer as a network printer.

Close

OK
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Log in using an account with the administrator's right.

Windows 2000/XP

1 Open the Printers folder.

Right-click on your desired printer (Ex.
Panasonic DP-3000) and select Properties
from the pop-up menu.

The printer properties dialog box appears.

2 Select the Ports Tab and click on the

 button.Add Port...

Continued on the next page...
25



Installing the LPR (Line Printer Remote) Monitor

26

Windows 2000/XP
3 Select Standard TCP/IP Port and click the

 button.

4 Click on the  button.

5 Enter the IP Address and the Port Name and

click the  button.

Note: The Port Name is automatically
entered by Windows 2000/XP. You
may change this as required.

New Port ...

Next

Next
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Windows 2000/XP
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6 Select Custom and click the 

button.

7 1. Under the Protocol, select LPR.
2. Under the LPR Settings, enter the

Queue Name (Ex. LPR1) and check the
LPR Byte Counting Enabled.

3. Click on the  button.

8 Click on the  button.

Click on the  button.

The printer properties dialog box is closed and
you have now configured the printer as a
network printer.

Settings...

OK

Next

OK

Continued on the next page...
27
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Windows 2000/XP
9 Click on the  button.

10 Click on the  button.

11 Click on the  button.

Click on the  button.

The printer properties dialog box is closed and
you have now configured the printer as a
network printer.

Finish

Close

Apply

OK
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Configuring the Printer Driver Settings

To change the printer settings, open the dialog box for the printer properties by the following steps.

NOTE 1. Upon printing, changing the properties of Paper/Layout, Handling, Quality and Device
Options is allowed by clicking Properties in the print dialog box of an application.

2. Sharing Tab in property dialog box is not displayed unless printer sharing has been specified.

Windows 95/98/Me

1 Click the Start button, point to Settings, and then click
Printers.

2 Right-click the desired printer icon in the printers folder,
and select Properties in the pop-up menu.

The printer properties dialog box appears.
29
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Windows 95/98/Me

General Tab

1. Comment
Enter comments to the properties, if any.
If another user sets up this printer on his or her computer when sharing the printer, the comment specified
here will also appear on that computer. However, the comment displayed for an already set-up user will
remain unchanged even if the comment is modified later.

2. Separator page
This feature is not available on your machine.

3.  button
Prints a test page. This allows the user to verify if the printer is installed properly.

Print Test Page
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Details Tab

1. Print to the following port
Displays either the port to which the printer is connected or the path to the network printer.
To change the printing destination, either select the printing destination port from the list or enter the
network path here.

2. Print using the following driver
Displays the type of the printer driver. Specify the printer being used or a printer model which can be
emulated with the printer being used.

3.  /  button
Assigns a port to the network drive or cancels a port assigned to the network drive.

4. Timeout settings - Not selected
Specify the amount of time (in seconds) allowed to elapse before the printer becomes online. If the printer
is not online within this duration, an error message will be displayed.

5. Timeout settings - Transmission retry
Specify the amount of time (in seconds) allowed to elapse before the printer is ready for printing. If the
printer is not ready for printing within this duration, an error message will be displayed.
Increase this value if a timeout error occurs when printing a large document.

6.  /  button
Adds/deletes a new port or a new network path.

7.  button
Updates or modifies the printer driver.

Capture Printer Port... End Capture...

Add Port... Delete Port...

New Driver...
31



Configuring the Printer Driver Settings

32

Windows 95/98/Me

8.  button

Specify the method of sending (spool) documents from the program to the printer.
• Spool Data Type

Select spool data type (EMF format or RAW format). Specifying RAW format results in longer time
before placing an application operational after printing on the application.

Note: Spooling by EMF format (metafile compression) may cause the following problems on some
application software.
1) Printing result is different from the screen display.
2) Printing requires excessive time.

• Enable bidirectional support
Be sure to check the check box for "Enable bidirectional support" when installing the status monitor
(See page 123). Otherwise, printing may not function properly.

9.  button
Modifies printer port settings.

Spool Settings...

Port Settings...
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Sharing Tab

1. Not Shared/Shared As
Select whether to display or use this printer with other computers.

2. Share Name
Specify the name of the shared printer. The displayed name can be used as it is or a new name may be
entered. The name specified at this time will be displayed when other users view information about the
printer on the network.

3. Comment
You can enter comment regarding a shared printer (such as the type of printer and the location where it is
installed). When other users view information about the printer on the network, the comment specified
here will be displayed.

4. Password
Specify a password when other users will connect to this printer.
Leave the box blank in order not to use any password.

NOTE 1. Sharing Tab in property dialog box is not displayed unless printer sharing has been specified.
33
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Windows 95/98/Me

Paper/Layout Tab 

1. Paper Size
Select a document size.

2. Paper Source
Specify where the paper you want to use is located in the machine. If you choose Auto Selection, the
printer driver will automatically select an appropriate tray according to the Paper Size.

3. Orientation
Select the print orientation (Portrait/Landscape).

4. Copies (1-99)
Specify the number of copies to be printed. If the number of copies to be printed can be specified within
the application, indicate one copy here and specify the number of copies in the Print dialog box of the
application.

5. Zoom (50-200%)
Specify an enlargement or reduction percentage when printing documents. If enlargement/reduction can
be set within the application, indicate 100% here and specify the enlargement/reduction percentage in
the Print dialog box of the application.

6. N in 1
For printing two or more pages on one sheet, specify a printing method.

Layout is selected by combining with "Orientation." Each layout is displayed with the icon.
• 2 in 1: Print 2 pages of documents zoomed out by 65 or 71% on one sheet.
• 4 in 1: Print 4 pages of documents zoomed out by 50% on one sheet.

7.  button
Return all items in Paper/Layout Tab to standard settings (default).

Restore Defaults
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Handling Tab

1. Sorter
Select whether to Stack or Sort when printing multiple copies.

2. Printing on both sides (Duplex) (For DP-150FX/2000/2010E/2500/3000)
Select duplex printing for printing on both sides.

Note 1) Duplex Printing is allowed only when the Dual-Path Exit Guide Unit, Paper Transport Unit and
Automatic Duplex Unit (DA-FK200/FK210/MD200) are mounted.

2) Check [Duplex Unit] check box in Device Options Tab.

3. Flipping Direction
Select binding side (Long Edge/Short Edge) for duplex printing.

4. Binding Margin (For DP-2000/2010E/2500/3000)
Select the binding margin upon duplex printing.
The width of the binding margin is specified on the main unit.

5. Output Tray (For DP-2000/2500/3000)
Specify the output destination (Auto Selection, Inner Tray 1, Inner Tray 2 or Outer Tray).

Note 1) Output Tray selection is allowed only with Dual-Path Exit Guide Unit, Paper Transport Unit, Exit
Tray (Outer) or 1-Bin Finisher (DA-FK200/FK210/XT200/FS200) is installed.

2) Check [Inner Tray], [Finisher / Outer Tray] check boxes in Device Options Tab.
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6. Staple (For DP-2000/2500/3000)

Specifying staple printing is allowed if the output bin is set to outer.
Note 1) Staple printing is allowed only with Electronic Sorting Board (DA-ES200 : For DP-2000 only) and

1-Bin Finisher (DA-FS200) mounted.
2) Select "Sort" in the sort menu.
3) Paper is stapled at the top left or at the top right. (See table below.)

Document orientation Paper orientation Stapling position

Letter
A4

Letter
A4

Letter
A4

Top left

Letter/A4

Letter
A4

Top right

Note) Stapling on Invoice/B5
     sheet is not allowed.

Letter/A4

Letter
A4

Letter/A4

Top right

Letter/A4
Letter/A4

Top left

Note) Stapling on Invoice/B5
          sheet is not allowed.

Ledger
Legal

A3
FLS
B4 Ledger/

Legal/
A3/FLS/B4

Ledger
Legal

A3
FLS
B4

Top right

Note) Stapling on Invoice/B5 sheet is
          not allowed.

Ledger/
Legal/

A3/FLS/B4

Ledger/
Legal/

A3/FLS/B4

Top left

Note)  Stapling on Invoice/B5 sheet is
           not allowed.
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Quality Tab

1. Halftone
Select method of expressing halftone. Select the setting according to the data to be printed and your
preference
• Normal: Select the halftoning method to be used. Select it according to the details of data and your

preference.
• Line Art:  Use when printing originals containing line drawings or text.

2. Resolution
Select the printer resolution (300dpi/600dpi).

3. Density
Adjust the printing density (Contrast and Brightness) as desired.

4.  button
Return all items in the Quality Tab to standard settings (default).

NOTE 1. dpi (dot per inch) means the number of dots contained in one inch.  The higher the value is, the
higher the resolution becomes. 

Restore Defaults
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Device Options Tab

1. Security Print Password (For DP-1810F/2000/2500/3000)
Set the password for Security Print, to enable the feature.

2. Duplex Unit (For DP-2000/2500)
Check this checkbox if the Automatic Duplex Unit (DA-MD200) is installed.

3. Inner Tray (For DP-2000/2500/3000)
Check this checkbox if the Exit Tray (Inner) and the Dual-Path Exit Guide Unit (DA-XN200/FK200) are
installed.
Specifying inner bins, Inner 1 and Inner 2, is allowed for printing on the printer.

4. Finisher/Outer Tray (For DP-2000/2500/3000)
Check this checkbox if the 1-Bin Finisher (DA-FS200) or Outer Tray (DA-XT200) is installed.
Setting of Finisher/Outer Tray option is allowed when the Inner Tray option is enabled. The staple
function also is selectable when the Finisher/Outer Tray option is enabled.

5. Number of Paper Tray
Select the number of available paper trays for the printer if an optional Paper Feed Module is installed.

6. Printer/Fax Memory (For DP-1810F/2000/2500/3000)
Select the size of the Expansion Flash Memory Card or whether a Fax Option (2MB) has been installed,
to enable the Security Print.

7.  button
Return all items in the Device Options Tab to standard settings (default).

8.  button
Displays the version information about the printer driver.

NOTE 1. Device Options Tab specifies device-specific settings and settings of optional devices.

Restore Defaults

About...
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To change the printer settings, open the dialog box for the printer properties by the following steps.

NOTE 1. In Windows NT 4.0, setting the properties depends on the log-in account. This section
describes properties to be specified by an administrator (system manager).

2. See "Configuring the Printer Driver Settings (User)" for details of user properties.  (See page
47)

Windows NT 4.0 (Administrator)

1 Log onto the computer/network with an account rights of
Administrator.

2 Click the Start button, point to Settings, and then click
Printers.

3 Right-click the desired printer icon in the printers folder,
and select Properties in the pop-up menu.

The printer properties dialog box appears.
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General Tab

1. Comment
Enter comments to the properties, if any.
If another user sets up this printer on his or her computer when sharing the printer, the comment specified
here will also appear on that computer. However, the comment displayed for an already set-up user will
remain unchanged even if the comment is modified later.

2. Location
Specify the printer location.

3. Driver
Displays the printer driver type. Specify the printer being used or a printer model that can be emulated
with the printer being used.

4.  button
Updates or modifies the printer driver.

5.  button
This feature is not available on your machine.

6.  button
Specify the processor to be used for printing (Print Processor) and the data type (Default Data type).
The processor and data type affect the manner in which the printer functions in Windows NT. Normally
they do not need to be modified. However, modification might be necessary when the printer is used with
a special application.

7.  button
Prints a test page. This allows the user to verify if the printer is installed properly.

New Driver...

Separator Page...

Print Processor...

Print Test Page
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Ports Tab

1. Print to the following port(s)
Displays a list of available ports for printing (Port), their status (Description) and printers that are
connected to these ports (Printer).

2.  /  button
Adds/deletes a new port or a new network path.

3.  button
Configures the selected port. In case of a parallel port, Transmission Retry should be specified.

4. Enable bidirectional support
On a printer, this setting enables reception of configuration data and status data from computer. Be sure
to check this checkbox when installing status monitor  (See page 123). Printing may be disabled without
checking on the checkbox.

5. Enable printer pooling
Printer spool allows outputting data from one logical printer to two or more printers. With printer spool
enabled, a transmitted printing job is output to the first printer that is available for printing.

NOTE 1. Specify the time (seconds) waiting for the printer to be ready for printing. If a printer is not
ready for printing after the specified time has elapsed, an error message is displayed.

2. If a timeout error occurs frequently upon printing a large size document, specify a larger value
here.

Add Port... Delete Port...

Configure Port...
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Scheduling Tab

1. Available
Schedules the printer for operation. Specify operating hours when From-To is selected.

2. Priority
Sets printing priority. The slider allows the priority to be adjusted from 1 through 99.

3. Spool print documents... / Print directly to the printer
Specify how documents should be sent from the application to the printer.

4. Hold mismatched documents
The spooler compares document settings against printer settings and holds printing of a document if its
settings (Paper Size, Orientation, and so on) do not match the printer settings.

5. Print spooled documents first
Always prints spooled documents first regardless of printing priority.

6. Keep documents after they have printed
Holds documents in the print queue even after they have been printed. These documents can be printed
again directly from the queue regardless of the state the application is in.
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Sharing Tab

1. Not Shared/Shared
Select whether to display or use this printer with other computers.

2. Share Name
Specify the name of the shared printer. The displayed name can be used as it is or a new name may be
entered. The name specified at this time will be displayed when other users view information about the
printer on the network.

3. Alternate Drivers
Specify the operating systems of other computers that might share this printer.

NOTE 1. When sharing a printer on the network, the print driver is installed on one print server, other
computers will automatically copy and use that driver.

2. For this reason, the print server must be ready with printer drivers for all the operating systems
of all computers that will be sharing the printer.
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Security Tab

1.  button
Set printer access privileges.

2.  button
Displays the persons who used this printer and how they used.

3.  button
Set the ownership of the printer.

NOTE 1. In order to utilize these features, you need to have selected Audit... from User Manager's
Policies and have enabled File and Object Access in the Audit Policy dialog box.

Permissions

Auditing

Ownership
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Device Settings Tab

1. Halftone Setup
 button

Select the halftoning method to be used (halftones specific to the printer).
Select it according to the details of data and your preference.

• Halftone Pattern
Select the pixel size to be used for halftones.
The greater the value, the coarser the image would become. However, a larger value is suited to printing
in large areas.
The Enhanced pattern allows printing at a higher resolution using the same number of pixels. However,
the pattern might generate unnatural lines, patterns, moire effects, and so on depending on the image to
be printed.

• Device Gamma
Adjust the gamma of print images (color intensities).

• Pixel Diameter
Adjust the darkness of the print image. Manipulate the slider to specify the pixel size. You can select
between specifying the real size in inches or specifying in percentage relative to the printer resolution.

Halftone Setup...
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• Luminance (CIE Y)

Adjust the luminosity of the print image.

2. Duplex Unit (For DP-2000/2500)
Check this checkbox if the Automatic Duplex Unit (DA-MD200) is installed.
Duplex printing function is enabled.

3. Output Tray (For DP-2000/2500/3000)
If Exit Tray (Inner) and Dual-Path Exit Guide Unit (DA-XN200/FK200) are installed, select inner option.
This allows specifying Inner 1 and Inner 2 as output bins for printer output.
If 1-Bin Finisher or Exit Tray (Outer) (DA-FS200/XT200) is installed, select inner option + outer option.
This allows specifying inner 1, inner 2, and outer as output bins for printer output. Also, stapling function
becomes available if inner option and outer option are enabled.

4. Number of Paper Tray
Select the number of available paper trays for the printer if an optional Paper Feed Module is installed.

5. Printer/Fax Memory (For DP-1810F/2000/2500/3000)
Select the size of the Expansion Flash Memory Card to enable the Secure Print.

6. Secure Print Password (DP-1810F/2000/2500/3000)
Set the password for Security Print, to enable the feature.

NOTE 1. Device Settings Tab specifies device-specific settings and settings of optional devices. Refer
to the operation manuals of the optional devices, or on-line manuals for settings items.

2. Settings specified in this section are saved as standard (default) settings of the printer.
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To change the printer settings, open the dialog box for the printer properties by the following steps.

NOTE 1. In Windows NT 4.0, setting properties depends on the log-in account. This section describes
properties to be specified by a user, upon executing a print operation on an application. See
"Configuring the Printer Driver Settings (Administrator)" for details of administrator properties.
(See page 39)

Windows NT 4.0 (User)

1 Select Print in the File menu of the application.

2 Select the printer model in the name box.

3 Click the  button in the Print dialog box.

4 The printer properties dialog box appears. Click the
desired tabs of the dialog box and specify the properties.

Properties...
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Page Setup Tab

1. Paper Size
Select a document size.

2. Paper Source
Specify where the paper you want to use is located in the machine. If you choose Auto Selection, the
printer driver will automatically select an appropriate tray according to the Paper Size.

3. Copy Count
Specify the number of copies to be printed. If the number of copies to be printed can be specified within
the application, indicate one copy here and specify the number of copies in the Print dialog box of the
application.

4. Sort
Select whether to Stack or Sort when printing multiple copies.

5. Orientation
Select the print orientation (Portrait/Landscape).

6. Print on Both Sides (Duplex Printing) (For DP-150FX/2000/2010E/2500/3000)
Specify if duplex printing is performed. Select the binding side (None/Short Edge/Long Edge) for duplex
printing.

Note 1) Duplex Printing on post card is not allowed.
2) Duplex Printing is allowed only when the Dual-Path Exit Guide Unit, Paper Transport Unit and

Automatic Duplex Unit are mounted.
3) Check [Duplex Unit] check box in Device Options Tab.
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Advanced Tab

1. Paper Size
Select a document size.

2. Orientation
Select the print orientation (Portrait/Landscape).

3. Paper Source
Specify where the paper you want to use is located in the machine. If you choose Auto Selection, the
printer driver will automatically select an appropriate tray according to the Paper Size.

4. Copy Count
Specify the number of copies to be printed. If the number of copies to be printed can be specified within
the application, indicate one copy here and specify the number of copies in the Print dialog box of the
application.

5. Print on Both Sides (Duplex Printing) (For DP-150FX/2000/2010E/2500/3000)
Specify if duplex printing is performed.

6. Resolution
Select the printer resolution (300dpi/600dpi).

7. Scaling
Specify custom zoom when printing a document by zooming in/out at a desired rate. If the zooming rate is
specifiable in an application, specify "100%" (same size) here. Specify a zooming rate in the print dialog
box of the application.

NOTE 1. Settings specified in this section are valid until an application is shut down.
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Advanced Tab

1. Metafile Spooling
With Metafile Spooling enabled, the file is spooled in EMF format (metafile compression). With the
function disabled, the file is spooled in RAW (non-compression) format. Specifying RAW format results in
longer time before placing an application operational after printing on the application.

Note: Spooling by EMF format may cause the following problems on some application software.
1)Printing result is different from the screen display.
2)Printing requires excessive time.

2. N in 1
For printing two or more pages on one sheet, specify a printing method.
Layout is selected by combining with "Orientation." Each layout is displayed with an icon.
2 in 1: Print 2 pages of documents zoomed out by 65 or 71% on one sheet.
4 in 1: Print 4 pages of documents zoomed out by 50% on one sheet.

3. Binding Margin (For DP-2000/2010E/2500/3000)
Select the binding margin upon duplex printing.
The width of the binding margin is specified on the main unit.
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4. Staple (DP-2000/2500/3000)
Specifying staple printing is allowed if the output bin is set to outer.

Note 1) Staple printing is allowed only with Electronic Sorting Board (DA-ES200 : For DP-2000 only) and
1-Bin Finisher (DA-FS200) mounted.

2) Paper is stapled at the top left or at the top right. (See table below.)

Document orientation Paper orientation Stapling position

Letter
A4

Letter
A4

Letter
A4

Top left

Letter/A4

Letter
A4

Top right

Note) Stapling on Invoice/B5
     sheet is not allowed.

Letter/A4

Letter
A4

Letter/A4

Top right

Letter/A4
Letter/A4

Top left

Note) Stapling on Invoice/B5
          sheet is not allowed.

Ledger
Legal

A3
FLS
B4 Ledger/

Legal/
A3/FLS/B4

Ledger
Legal

A3
FLS
B4

Top right

Note) Stapling on Invoice/B5 sheet is
          not allowed.

Ledger/
Legal/

A3/FLS/B4

Ledger/
Legal/

A3/FLS/B4

Top left

Note)  Stapling on Invoice/B5 sheet is
           not allowed.
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5. Output Tray

Specify the output destination.
Note 1) Output Tray selection is allowed only with Dual-Path Exit Guide Unit, Paper Transport Unit, Exit

Tray (Outer) or 1-Bin Finisher (DA-FK200/FK210/XT200/FS200) is installed.
2) Post cards cannot be output from the outer tray.

6. Security Print
Select to enable Security Print.

7. Halftone Color Adjustment

• Contrast
Adjust the contrast of print images.

• Brightness
Adjust the brightness of print images.

• Dark Picture
Select this option in order to print dark images brighter.

• Negative
Select this option in order to print images with black and white reversed.

• Input RGB Gamma
Adjust the gamma of print images (color intensities). Red, Green and Blue can also be adjusted
individually.

• Black Ref/White Ref
Adjust the difference between the darkest and lightest colors of an image. Increasing the Black Ref
value or decreasing the White Ref value will intensify the contrast of the image but reduces the range of
colors in between.

• Picture
Select a test pattern type.
Selecting the View check box will display halftone adjustment results in the test pattern.

NOTE 1. Settings specified in this section are valid until an application is shut down.
2. Specifying [Yes] for [Binding Margin] moves a printing area vertically or horizontally (for

ensuring binding margin). For specifying margin in consideration of a double-page spread
printing on application, specify [No] for [Binding Margin].
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To change the printer settings, open the dialog box for the printer properties by the following steps.

NOTE 1. In Windows 2000/XP, setting the properties depends on the log-in accounts. This section
describes properties to be specified by an administrator (system manager). See "Configuring
the Printer Driver Settings" for details of user properties. (See page 62)

Windows 2000/XP (Administrator)

1 Log onto the computer/network with an account rights of
Administrator.

2 Click the Start button, point to Settings, and then click
Printers.

3 Right-click the desired printer icon in the printers folder,
and select Properties in the pop-up menu.

The printer properties dialog box appears.
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General Tab

1. Printer Name
Name of the printer specified upon installation is displayed.

2. Location and Comment
Enter a comment about the location of the printer installation and information about the printer.

If a printer is shared, the location and comment specified in this field appears when another user sets up
this printer on his/her computer. After completion of setup, however, changing this comment does not
update the location and comment appearing on users PCs.

3. Model
Model name of the printer is displayed.

4. Features
Functions and settings of the printer are displayed.

5.  button
Changes properties (print settings) specifiable for each user.
Refer to "Configuring the Printer Driver Settings" for details of settings  (See page 62)

6.  button
Prints a test page. This allows the user to verify if the printer is installed properly.

Printing Preferences...

Print Test Page
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Sharing Tab

1. Not Shared/Shared As
Specify if this printer is displayed or used on a computer of other users.

For sharing a printer, specify the share name of a printer to be shared. A name specified here appears
when other users view the printer information on a network

2.  button
Install additional printer drivers on the system.

When users running different versions of Windows share a printer, installing additional drivers avoids the
necessity for installing new drivers on their systems.

NOTE 1. If a printer is shared on a network, installing the printer driver on one print server allows other
computers to copy the driver automatically for use. Accordingly, a print server is required to
provide alternative printer drivers for other OS's that may use the printer.

Additional Drivers...
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Ports Tab

1. Print to the following port(s)
Displays a list of ports that allows printing, their status (description), and printers connected to the ports.

2.  /  button
Adds/deletes a new port or a new network path.

3.  button
Configure the port that is selected. On a parallel port, wait time (in seconds) for retransmission is
specified.

4. Enable bidirectional support
On a printer, this setting enables reception of configuration data and status data from computer. Be sure
to check this checkbox when installing status monitor  (See page 123). Printing may be disabled without
checking on the checkbox.

5. Enable printer pooling
Printer spool allows outputting data from one logical printer to two or more printers. With printer spool
enabled, a transmitted printing job is output to the first printer that is available for printing.

NOTE 1. Specify the time (seconds) waiting for the printer to be ready for printing. If a printer is not
ready for printing after the specified time has elapsed, an error message is displayed.

2. If a timeout error occurs frequently upon printing a large size document, specify a larger value
here.

Add Port... Delete Port...

Configure Port...
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Advanced Tab

1. Always available/Available from
Specify the operation schedule for a printer. Selecting Available from allows specifying an operation
time.

2. Priority
Specify the priority in printing. Priority is adjustable from 1 to 99. Document of higher priority are printed
before those of lower priority.

3. Driver
Displays the printer driver type. Specify the printer being used or a printer model that can be emulated
with the printer being used.

4.  button
Updates or modifies the printer driver.

5. Spool print documents so program finishes printing faster
Specify the method of sending a document from the program to the printer.

6. Hold mismatched documents
The spooler compares document settings against printer settings and holds printing of a document if its
settings (Paper Size, Orientation, and so on) do not match the printer settings.

7. Print spooled documents first
Always prints spooled documents first regardless of printing priority.

8. Keep printed documents
After printing, documents are kept in the queue. The documents are allowed to be reprinted directly from
the queue regardless of the status of an application.

New Driver...
57



Configuring the Printer Driver Settings

58

Windows 2000/XP (Administrator)

9. Enable advanced printing features

Enables advanced printing features. Optional features of the printer (page ordering, booklet printing,
numbering on sheets) are enabled. These features can be disabled if a problem occurs due to
incompatibility. Disabling the features may disable the printing options also.

10.  button
Specifies standard (default) values for the properties (print settings) specifiable for each user. If a local
printer is shared, the settings here are used as printing defaults for other users.

Refer to "Configuring the Printer Driver Settings" for detailed settings.  (See page 62)

11.  button
Specify a print processor and data type to be used for printing.
The processor and data type define operations of printers on Windows 2000/XP.
Usually no change is required in the settings. Use of a printer on a special application, however, may
require changes on the settings.

12.  button
This feature is not available on your machine.

Printing Defaults...

Print Processor...

Separator Page...
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Security Tab

Displays a list of users and groups that are assigned access to this printer. A list of standard access
permitted/prohibited for each group or user is displayed. Check the checkbox for permitting or prohibiting
access. Gray checkbox indicates inheritance of access permission.

1.  /  button
Add or delete a user or group in the list.

2.  button
Specify access to a printer, audit, and owner.

NOTE 1. Windows 2000/XP provides the capability of managing access to various objects (e.g. printers)
by users.

2. Refer to manuals of Windows 2000/XP for details of access permission, audit, and owner.

Add... Remove

Advanced...
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Device Settings Tab

1.  button
Select the method of expressing device halftone (printer-specific halftone). Select the settings according
to printing data and preference.

• Halftone Pattern
Select the pixel size to be used for halftones.
The greater the value, the coarser the image would become. However, a larger value is suited to printing
in large areas.
The Enhanced pattern allows printing at a higher resolution using the same number of pixels. However,
the pattern might generate unnatural lines, patterns, moire effects, and so on depending on the image to
be printed.

• Device Gamma
Adjust the gamma of print images (color intensities).

• Pixel Diameter
Adjust the darkness of the print image. Manipulate the slider to specify the pixel size. You can select
between specifying the real size in inches or specifying in percentage relative to the printer resolution.

• Luminance (CIE Y)
Adjust the luminosity of the print image.

Halftone Setup...
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2. Duplex Unit (For DP-2000/2500)
Check this checkbox if the Automatic Duplex Unit (DA-MD200) is installed.
Duplex printing function is enabled.

3. Output Tray (For DP-2000/2500/3000)
If Exit Tray (Inner) and Dual-Path Exit Guide Unit (DA-XN200/FK200) are installed, select inner option.
This allows specifying Inner 1 and Inner 2 as output bins for printer output.
If 1-Bin Finisher or Exit Tray (Outer) (DA-FS200/XT200) is installed, select inner option + outer option.
This allows specifying inner 1, inner 2, and outer as output bins for printer output. Also, stapling function
becomes available if inner option and outer option are enabled.

4. Number of Paper Tray
Select the number of available paper trays for the printer if an optional Paper Feed Module is installed.

5. Printer/Fax Memory (For DP-1810F/2000/2500/3000)
Select the size of the Expansion Flash Memory Card or whether a Fax Option (2MB) has been installed,
to enable Security Print.

6. Security Print Password (For DP-1810F/2000/2500/3000)
Set the password for Security Print, to enable the feature.

NOTE 1. Device Settings Tab specifies device-specific settings and settings of optional devices. Refer
to operation manuals of the optional devices, or on-line manuals for settings items.

2. Settings specified in this section are saved as standard (default) settings of the printer.
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To change the printer settings, open the dialog box for the printer properties by the following steps.

NOTE 1. In Windows 2000/XP, setting the properties depends on the log-in accounts. This section
describes properties to be specified by a user, upon executing a print operation on an
application. See "Settings Printer Driver on Windows 2000/XP (Administrator)" for details of
administrator (system manager) properties.  (See page 53)

Windows 2000/XP (User)

1 Select Print in the File menu of the application.

2 Click the  button in the Print dialog box. 

3 The dialog box for the printer properties appears. Click
the desired tabs of the dialog box and specify the
properties.

Properties...
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General Tab

1. Select Printer
Select a printer for printing.

2. Page Range
Select a page range for printing.

3. Number of Copies (1-99)
Specify the number of copies.

4. Collate
Upon printing two or more copies, pages are output for each copy.
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Layout Tab

1. Orientation
Select the print orientation (Portrait/Landscape).

2. Print on Both Sides (Duplex) (For DP-150FX/2000/2010E/2500/3000)
Select duplex printing for printing on both sides.
Select the binding side (None/Flip on Short Edge/Flip on Long Edge) for duplex printing.

Note 1) Duplex Printing on post card is not allowed.
2) Duplex Printing is allowed only when the Dual-Path Exit Guide Unit, Paper Transport Unit and

Automatic Duplex Unit are mounted.
3) Check [Duplex Unit] check box in Device Options Tab.

3.  button
Specify detailed settings. Refer to Advanced (See page 66) for details.

Advanced...
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Paper/Quality Tab

1. Paper Source
Specify where the paper you want to use is located in the machine. If you choose Auto Selection, the
printer driver will automatically select an appropriate tray according to the Paper Size.

2.  button
Specify detailed settings. Refer to Advanced (See page 66) for details.

Advanced...
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Advanced

1. Paper Size
Select a document size.

2. Resolution
Select the printer resolution (300dpi/600dpi).

3. Scaling
Specify custom zoom when printing a document by zooming in/out at a desired rate. If the zooming rate is
specifiable in an application, specify "100%" (same size) here. Specify a zooming rate in the print dialog
box of the application.

4. Metafile Spooling
With Metafile Spooling enabled, the file is spooled in EMF format (metafile compression). With the
function disabled, the file is spooled in RAW (non-compression) format. Specifying RAW format results in
longer time before placing an application operational after printing on the application.

Note: Spooling by EMF format may cause the following problems on some application software.
1)Printing result is different from the screen display.
2)Printing requires excessive time.

5. N in 1
For printing two or more pages on one sheet, specify a printing method.
Layout is selected by combining with "Orientation." Each layout is displayed with an icon.
2 in 1: Print 2 pages of documents zoomed out by 65 or 71% on one sheet.
4 in 1: Print 4 pages of documents zoomed out by 50% on one sheet.

6. Binding Margin (For DP-2000/2010E/2500/3000)
Select for ensuring the binding margin upon duplex printing.
Specifying On for Binding moves a printing area vertically or horizontally (for ensuring binding margin).
For specifying a margin in consideration of a double-page spread printing on application, specify Off for
Binding.
Width of binding margin is specified on the main unit.
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7. Staple (For DP-2000/2500/3000)
Specifying staple printing is allowed if the output bin is set to outer.

Note 1) Staple printing is allowed only with Electronic Sorting Board (DA-ES200 : For DP-2000 only) and
1-Bin Finisher (DA-FS200) mounted.

2) Paper is stapled at the top left or at the top right. (See table below.)

Document orientation Paper orientation Stapling position

Letter
A4

Letter
A4

Letter
A4

Top left

Letter/A4

Letter
A4

Top right

Note) Stapling on Invoice/B5
     sheet is not allowed.

Letter/A4

Letter
A4

Letter/A4

Top right

Letter/A4
Letter/A4

Top left

Note) Stapling on Invoice/B5
          sheet is not allowed.

Ledger
Legal

A3
FLS
B4 Ledger/

Legal/
A3/FLS/B4

Ledger
Legal

A3
FLS
B4

Top right

Note) Stapling on Invoice/B5 sheet is
          not allowed.

Ledger/
Legal/

A3/FLS/B4

Ledger/
Legal/

A3/FLS/B4

Top left

Note)  Stapling on Invoice/B5 sheet is
           not allowed.
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8. Output Tray (For DP-2000/2500/3000)

Specify the output destination. <Auto Selection, Outer, Inner 1, or Inner 2>
Note 1) Output Tray selection is allowed only with Dual-Path Exit Guide Unit, Paper Transport Unit, Exit

Tray (Outer) or 1-Bin Finisher (DA-FK200/FK210/XT200/FS200) is installed.
2) Post cards cannot be output from the outer tray.

9. Security Print
Select to enable Security Print.

10.Halftone Color Adjustment

• Contrast
Adjust the contrast of print images.

• Brightness
Adjust the brightness of print images.

• Dark Picture
Select this option in order to print dark images brighter.

• Negative
Select this option in order to print images with black and white reversed.

• Input RGB Gamma
Adjust the gamma of print images (color intensities). Red, Green and Blue can also be adjusted
individually.

• Black Ref/White Ref
Adjust the difference between the darkest and lightest colors of an image. Increasing the Black Ref
value or decreasing the White Ref value will intensify the contrast of the image but reduces the range of
colors in between.

• Picture
Select a test pattern type.
Selecting the View check box will display halftone adjustment results in the test pattern.
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Print Operation

If the printer driver is installed properly and a printer is selected as the default printer in the printer setup,
printing can be accomplished from any Windows application with simple operations.

To print from most Windows applications, use the Print... command on the File menu. Selecting the Print...
command typically displays the following Print dialog box:

After selecting the print range to be printed and the number of copies, click on  to start printing.

While documents are being printed, a printer icon appears on the System Tray near the clock on the bottom
right hand corner of the screen. The icon disappears when printing is completed.

You may double-click on the printer indicator on the System Tray to open and verify the details of the print
queue in the spooler.

NOTE 1. Follow the steps below to set a default printer:
1) Click the Start button and select Printers in the Settings menu.
2) Select the printer icon in the window and select [Set As Default] in dropdown menu by

right-clicking it. Then the check mark is displayed.

Printing from Windows Applications

OK
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For sharing a printer by connecting two computers via crossed-cable or using a hub, a connection among
computers must be established.

Establishing a connection among computers is verified by displaying the connected computers in Network
Neighborhood on the desktop.

The settings for printer sharing is specified by the following steps:

Printer server (PC connected to a printer)

Upon completion of the setting, the shape of the icon changes indicates it is shared.

NOTE 1. Refer to the manual of the network cards and Windows users guide for connection among
computers.

2. On Windows 95/98/Me, a computer connected to a printer must have been set up to allow
printer sharing by the following operations:
1) Double-click on the Network applet in the control panel folder, and then click on the

 button in the Network Configuration tab.
2) Check [I want to be able to allow others to print to my printer(s).] in the File and Print

Sharing dialog box.

Printing on Network

1 Install the printer driver on a computer to be connected to
the machine.

2 Click the Start button, point to Settings, and then click
Printers.

3 Right-click on the desired printer icon and select
[Sharing...] in the dropdown menu.

4 Select Shared As in the properties dialog box.

5 Click on the  button.OK

File and Print Sharing...
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Client workstation (PC that uses other computer's printer)

The operations above enable output from the client workstaton to a printer connected to a printer server.

1 Click the Start button, point to Settings, and then click
Printers.

2 Double-click Add Printer in the printers folder.
Add Printer Wizard appears.
Click on the  button.

3 Select Network Printer.
Click on the  button.

4 Specify the other computer's printer by entering the
network path.

Then, complete the installation by following the instruction
of the Add Printer Wizard.

Next

Next
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Document Management System Section

Installing the Document Management System

Windows 95/98/Me/NT/2000/XP

1 Insert the Panasonic Document Management
System CD-ROM.

2 Select the language.

3 Click on the  button.

4 Click Panasonic-DMS.
Note: The Fax Gateway and Firmware Update 

Utility is only available on U.S.A. and 
Canada only.

5 Click Install Panasonic-DMS Software.

Next
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6 Verify the installation destination and click the

 button.

7 Select your machine's model(s) and click the 

 (Add) button.  

Then, click the  button.

8 Click the Typical button.

9 Enter the program folder name and click the

 button.

Next

Next

Next

Continued on the next page...
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Windows 95/98/Me/NT/2000/XP
10 The required files are copied.

11 <For DP-1810F on Windows 95/98/NT only>

Click on the  button.

12 When the setup process is completed, a
message is displayed prompting you to restart
your computer.

Click the  button to restart your

computer.

OK

Finish
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The Panasonic Document Management System folder is added to the Start menu, and the installation is
completed.

13 <Windows 95/98/NT only>
Check [Yes, I accept....] and 

Click on the  button.

Note: After rebooting your PC, the Microsoft
Data Access Components is also
automatically installed. Log on to the
PC with an account rights of
Administrator when installing on
Windows NT 4.0.

Click on the  button.

Click on the  button.

Next

Next

Finish
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Windows 95/98/Me/NT/2000/XP
NOTE 1. When installing on Windows NT 4.0, log onto the computer with an account rights of
Administrator.

2. The Typical installation method installs all of the following drivers and applications.
Selecting the Custom installation allows the selected installation of scanner and MFP utilities
individually.
• Scanner

Document Scanner (TWAIN scanner driver)  (See page 94)
• Document Manager and Viewer

Document Manager (Image management application)  (See page 77)
Document Viewer (Image editing application)  (See page 100)

•PC Faxing
Panafax Desktop  (See page 147)

•MFP Utilities
Status Monitor (Device status monitor)  (See page 123)
Configuration Editor  (See page 128)
Phone Book Editor  (See page 136)
COM Port Redirector
Operating Instructions

3. By installing this software, the system selects LPT1 as the parallel port to be connected to the
device. For connecting the device to a port other than LPT1, change connection ports by
selecting [Panasonic], [Panasonic Document Management System], and [Port Selection Utility]
from the Start menu.

4. Before updating the software, be sure to remove the older version of software.
5. Take the following steps to install the software on Windows 2000/XP:

1) For installation, log onto the computer with an account rights of Administrator.
2) Restart Windows after completion of installation.
3) After restart, log on again with an account rights of Administrator to complete the Windows

system update.
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Document Manager

Document Manager is an application for managing documents (image files). By utilizing the Document
Manager and Document Viewer  (See page 100) in combination, a number of documents (image files) can
be classified, managed, browsed, and edited.

Selecting Panasonic → Panasonic Document Management System → Document Manager in
Programs of the Start menu displays the main window of the Document Manager.

1. Title Bar
Displays the title of a screen.

2. Menu Bar
Displays the menu of the Document Manager.

3. Tool Bar
Displays the tool buttons of the Document Manager. Tool buttons correspond to functions of the menus in
the menu bar.

4. Folder Window
Displays the folders containing the documents in tree form.

5. Link Icon
Dropping a dragged document onto a link icon, an application corresponding to the function of the icon is
activated.

6. Status Bar
Displays information such as the number of documents in a folder, the number of selected documents,
and file sizes, etc.

Main Window
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Main Window

7. Document Window

Displays a list of documents in the selected folder.
Documents are displayed in thumbnails (reduced images). Page number and  and  buttons are
displayed at the bottom of a thumbnail image for grouped documents (configured with two or more
pages).

• Image data files
A thumbnail image of the document is displayed.

• Application data files
A thumbnail image of the document with it original application icon is displayed (i.e. Word, Excel and
PowerPoint).

Clicking on the < and > buttons turns the page on a multi-page document.
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The Document Manager allows editing and managing documents displayed in thumbnail images by
dragging and dropping. The function enables various operations as described below:

Basic Operations

• Selecting Documents
Clicking thumbnail images in the document window allows
selection of documents. Dragging a mouse cursor on the
screen or clicking with the Shift key held down allows
selecting two or more documents at one time.

• Editing Documents
Double-clicking thumbnail images in document window
activates Document Viewer  (See page 100), allowing
opening and editing documents.

• Creating Documents
Drag and dropping any application file into Document
Manager creates a new document. A thumbnail image file is
created and the application icon is displayed.
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Basic Operations

• Copying/Moving Documents

Dragging a thumbnail image in document window and
dropping it onto a folder in the folder window allows moving
the document to the folder. Dragging & dropping with the Ctrl
key held down copies a document.

Dragging a document and dropping it onto another document
in a document folder results in grouping the two documents
together.

Dragging a document and dropping onto a link icon activates
an application corresponding to the function of each icon.
Link icons are registered and deleted by selecting Launch to
Another Application → External Application Setup in the
File menu.

• Dragging a document and dropping it onto “Shared Folder”
allows other computers connected to the same network
access to it.
Browse “Shared Folder” for how to create shared folders.
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• Import document (from scanner)
Selecting Acquire Image... in the File menu displays a window for the Document Scanner  (See page 83).
The operation imports a document read on the scanner into a folder.

• Import document (from file)
Selecting Open in the File menu displays a dialog box for selecting files. The dialog box allows importing
image files saved in a computer as documents onto a folder.

An attempt of importing files that cannot be handled by Document Manager results in displaying an error
shown below. Press OK and verify a file format.

Dragging and dropping a selected document onto a link icon at the bottom of the window activates an
application specified for the link icon, and opens the image file.

The link icons can be Added/Removed freely by selecting Launch to Another Application → External
Application Setup in the File menu.

The following applications are specifiable as destinations of the Document Manager:

- Draw/Graphics software (Applications such as MS-Paint, Photoshop etc.)
- OCR software (Application such as e-Typist, etc.)
- PC-FAX software
- E-Mail software (MAPI-compatible mail application such as MS-Outlook, Netscape Messenger etc.)
- Others

(Other application documents such as MS-Word, MS-Excel etc.)

NOTE 1. Document Viewer provides a function to add various graphics and texts to an image.
The graphics and texts added to an image are called "Annotation." See "Annotation Menu"
(See page 113) for details of annotation.

Setting Plug-in
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File Menu

• New Folder
Create a new folder under a folder that is currently selected.
Path of a folder to be created can be specified as required.

• Shared Folder
Create a new shared folder. Documents in “shared folder “
can be shared through a network from different computers.

• Released Shared Folder
Released a shared folder. Documents in  “shared folder”  will
be released from a network.

• Open
A file saved in the computer and can be imported into a folder
as a document.

• Save As
A document is saved as an ordinary image file under a
specified name.

• Rename
Change the name of a document.
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NOTE 1. See "Document Scanner"  (See page 94) for operation of scanner.

• Properties
Display the file properties.

• Backup
Backs up the documents stored in the selected folder.

• Acquire Image...
Using a scanner, etc. selected in Select Source, import a
document to a folder that is currently selected.

• Select Source
Select a TWAIN-compatible device for scanning documents.
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File Menu
NOTE 1. Print Setup specifies printing or not printing annotations edited in the Document Viewer. See
"Annotation Menu"  (See page 113) for details of annotation.

• Print
Print a document selected in the document window.

• Print Setup
Specify layout and printing size for a document to be printed.

1. Horizontal Position and Vertical Position
Adjust the printing position on a sheet.

2. Print Size
Select printing in original size or printing in accordance with
the sheet size.

3. N in 1
Select for printing reduced pages on one sheet.
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NOTE 1. See "Setting Plug-in"  (See page 81) for specifying an external application.

• Launch to another application
Opens a document selected in the document window with a
specified application.

Selecting External Application Setup displays a dialog box for
adding/changing/deleting the application.

Clicking the Add button displays a dialog box to Add External
Application.

1. Name
If an external application is specified, the name in this field
appears on a link icon.

2. Application Type
Specify the application type.

3. Program File
Specify the execution file of an application.

4. MAPI Correspondence
Check here if the E-mail application is compatible with MAPI.

5. Parameter
If the E-mail application is incompatible with MAPI, adding a
parameter here allows automatic activation of a transmission
screen.
85



Document Manager

86

File Menu
• Trash Can
- Open Trash Can

Opens the Trash Can and displays any files. Selecting

documents and clicking the  button restores
documents that have been discarded.

Click the  button to delete the selected
document.

- Empty Trash Can
Deletes the files in the Trash Can. If the documents are
emptied from the Trash Can, they are permanently deleted.
They are not stored in the Recycle Bin.

Undo

Delete
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NOTE 1. See "Annotation Menu"  (See page 113) for details of annotation.

Edit Menu

• Undo
Undo the last editing operation done.

• Cut
Delete a selected document from a folder and copy it to the
clipboard.

• Copy
Copy a selected document onto the clipboard.

• Paste
Paste a document from the clipboard onto a selected folder.

• Delete
Delete a selected document from a folder to the Trash Can.
A confirmation message for deletion appears.

• Select All
Select all documents in the folder.

• Find
Search for documents by specifying a document name,
creation date, or character string in the document.
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View Menu

• Tool Bar
Switch between displaying/hiding the tool bar.

• Status Bar
Switch between displaying/hiding the status bar.

• List Format/Thumbnail Format
Switch between list display and thumbnail display in the
document window.

• Arrange Folders
Sort the document folders by name or date.

• Arrange Document
Sort the documents in the current folder in the specified order
(Name, Type, Size or Date).

• Line Up Documents
Line up the documents in the document window.

• Refresh
Refreshes the contents of the Document  Manager.
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Document Menu

• Open
Open a selected document. Activates the Document Viewer
(See page 77) and opens a document for editing.

• Duplicate
Makes a copy of the selected document in a folder.

• Rotate
Rotate the selected document.
- Rotate Right
- Rotate 180 Degrees
- Rotate Left

• Group
Makes a group of two or more selected documents. The

grouped documents are indicated by page number and 

and  buttons at the bottom of a thumbnail image.

- Every Document
The selected documents are grouped.

- Every Page Alternately
Groups pages alternately.

- Every page reverse alternately
Groups pages alternately by reversing the pages.
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Document Menu

• Ungroup

Cancel the grouping for grouped documents. Either dividing
all pages into individual documents or releasing only specified
documents from a group can be selected.

• Enhancement
Apply the following correction to a selected document:

- Correct Skew
Detect any inclination of a document and automatically
correct it.

- Enhance Edge
Enhance edge (border) of image.

- Eliminate Noise
Remove noise on a document.

- Reverse Gradation
Display image in reverse.

• Page
Select pages to be displayed in thumbnail among grouped
documents.

Selecting Rearrange Page displays the page sorter dialog box.
The order of the pages are changed by selecting, dragging and
dropping the pages.
Click the Reverse Order button to reverse the page order.

• Attachment File
Open a dialog box to launch the application associated with
the selected attachment.

• File Conversion
Create image of the selected attachment.
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Image Converter

Once Panasonic-DMS has been installed, the Panasonic Document Manager (Image Converter) is
automatically installed in the Printers folder too.  This driver is for rasterizing application files such as Word
or Excel for placing them in the Document Manager.  To change the default properties,  follow the
instructions below:

1. Click the Start button, point to Settings and then click Printers.

2. Right-click on Panasonic Document Manager and select Properties from the dropdown menu.
The Properties dialog box appears.

3. Click on the  button to save the settings and close the Properties dialog box.

General Description

Windows 95/98/Me

• Paper/Layout tab

- Paper Size
Sets the document paper size.

- Orientation
Sets the document orientation.

- Resolution
Sets the document resolution.

• Quality tab

- Color
Sets the color document conversion to color or
monochrome.

- Monochrome
Select Normal (Black and White) or Grayscale (Photo) when
converting to monochrome. Also sets the brightness and
contrast. 

OK
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1. Click the Start button, point to Settings and then click Printers.

2. Right-click on Panasonic Document Manager and select Document Defaults from the dropdown
menu. The Document Properties dialog box appears.

3. Click on the  button to return to the Printers folder.

Windows NT 4.0

• Page Setup Tab

- Paper Size
Sets the document paper size.

- Orientation
Sets the document orientation.

- Color Appearance
Sets the document to color or grayscale.

• Advanced Tab

- Paper Size
Sets the document paper size.

- Orientation
Sets the document orientation.

- Resolution
Sets the document resolution.

- Color Appearance
Sets the document to color or grayscale.

- Metafile Spooling

- Halftone Color Adjustment

OK
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1. Click the Start button, point to Settings and then click Printers.

2. Right-click on Panasonic Document Manager and select Printing Preferences from the dropdown
menu. The Printing Defaults dialog box appears.

3. Click on the  button to return to the Printers folder.

Windows 2000/XP

• Layout tab
Sets the document orientation.

• Paper/Quality tab
Sets the document to color or grayscale.

• Advanced button
Sets the paper size, resolution and spooling properties.

OK
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Document Scanner

Upon image scanning, an image is imported directly into a document using a TWAIN-compatible application
(image editing software, etc.).

Selecting Acquire Image... in the File menu displays for the Document Scanner dialog box.

Main Window

1. Preview Window
Displays images of a preview scan. The black frame represents the actual scanning area (Output Size). You may
adjust/select the final scanning area by resizing the black frame over the desired area of the image. The size of the
black frame is shown in the Output Size field.

2. Image Type
Select the type of image to be scanned.

• Monochrome image (no halftone correction)
A method suitable for an image containing mainly text and drawings. Select this type when halftone correction
results in a blurred image.

• Halftone image (error diffusion)
This method, using no uniform pattern in halftone, is suitable for natural images such as photographs and
produces smooth images. The method, although requiring somewhat large file sizes, produces high-quality
images in comparison to the dither method.

• Halftone image (4x4, 8x8 dot dither)
This method, which produces images with a unique uniform pattern, is suitable for photographs.

• Halftone image (4x4 Bayer's dither)
This method, with somewhat lower image quality, reduces file sizes.

• Grayscale image (256 scales)
This method, best suitable to natural images such as photographs, produces tones with high fidelity by no
halftone correction. Compared to halftone image scanning, this method requires longer scanning times and
results in larger file sizes.

3. Resolution

Select the resolution for scanning.
Note: The Standard, Fine and Super Fine resolution are types that is best suitable if you are to send the images

to an ordinary fax machine in the future.

4. Paper Size

Select the size of originals to be scanned. The size and orientation of the preview window changes according to
the selected document size.

5. Lock
Fixes the size of the scanning area (black border) in the preview window, disallowing changing the size.
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NOTE 1. The menu for operating the Document Scanner (scanner driver) depends on the application.
Refer to the manuals of the application for details.

2. If a TWAIN-compatible application has not been installed, select Document Scanner from the
Start menu.

6. Slice Level (valid only when monochrome is selected)
Specify the value of distinction between monochrome for monochrome manuscript. Adjust the value according to
density of a manuscript to be scanned.

7. Brightness (valid only when halftone or grayscale is selected)

Adjust the brightness for halftone or grayscale documents.

8. Contrast (valid only when halftone or grayscale is selected)
Adjust the contrast (difference between dark and light) for halftone or grayscale documents.

9. Invert
Scan the image in negative.

10. Edge Enhancement

Scan the image with a highlighted edge.

11. Output Size
Displays size of the scanning image and the size of the scanned file.
The output size is determined by the size of the scanning area (black frame) in the preview window and the
resolution.

12. Unit
Select the unit of measurement (mm, inch, or pixel).

13.  button

Scan an image into the document desktop.

14.  button

Perform preview scanning and display the image on the preview window.

15.  /  button

Zoom in/out for a preview-scan image.

Scan

Preview

Zoom In Zoom Out
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• Adjustment - Gamma Curve
Display a dialog box for adjusting the gamma (color strength characteristics) of an image. (valid only when
halftone or grayscale is selected)

Adjust the gamma curve by dragging the slide bar or entering a value.

Moving the slide bar in the + direction reduces the difference between the highlight (light portion) and
halftone. Moving the slide bar in the - direction reduces the difference between the shadow (dark portion)
and halftone. In either case, the halftone becomes less prominent.

Click the  button to apply the changes.

NOTE 1. Adjustment in the Tool menu becomes valid only if <Halftone> or <Grayscale> have been
selected in <Image Type> on the main window.

Tool Menu

Apply
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• Adjustment - Highlight and Shadow
Displays a dialog box for adjusting the highlight and shadow. (valid only when halftone or grayscale is
selected)

Adjust the highlight and shadow by dragging the slide bar or entering a value. Enhancing the highlight
(bright portion) and the shadow (dark portion) makes clear shades on an image.

Click the  button to apply the changes.

• Parameter Reset
Return all settings in the Document Scanner to standard settings (default).

Apply
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Image scanning is performed by the following procedures:

Image Scanning

1 Activate TWAIN-compatible application.

2 Select Acquire Image... in the File menu
to display Document Scanner.

3 Specify the image type, resolution, and
paper size of a document to be scanned.

4 Place a document on the ADF and click

the  button.
A preview-scanned image is displayed in
the preview window.

5 Apply the following adjustments on the
preview image:

• Drag the scanning frame (black frame)
on the preview window to specify the
scanning area. If an area has already
been selected, double-clicking with
Shift key held down selects the whole
image.

• Clicking  / 
button zooms in/out a preview-scan
image.

• Adjust the Slice Level, brightness, and
contrast (difference between dark and
light portions) as required.

Preview

Zoom In Zoom Out
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NOTE 1. Adjust parameters for an optimum scanning image, with the view on preview image.
Preview scanning can be repeated any number of times.

2. Image scanning is only possible by the PC that the device is connected to directly through the
parallel port.

6 Click the  button to scan an
image into the document desktop.

Scan
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Document Viewer

The Document Viewer is an application for editing documents (image files) to be managed with the
Document Manager  (See page 77). In addition to usual image editing, the program provides various editing
capabilities for documents with a wide selection of annotation functions.

Double-clicking on the document (thumbnail) in the Document Manager screen or selecting Open in the
Document menu displays the main window of the Document Viewer.

NOTE 1. The program is activated also by selecting Panasonic → Panasonic Document
Management System  → Document Viewer from Programs of the Start menu.

Main Window
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1. Title Bar
Displays the title of the screen and the name of the image file being displayed.

2. Menu Bar
Displays the menu of the Document Viewer.

3. Tool Bar
Displays the tool buttons of the Document Viewer. Tool buttons correspond to functions of the menus in
the menu bar.

4. Page List
Displays the pages of the documents as thumbnails (reduced image).

5. Size Bar
Adjusts the scaling of the display on the image window.

6. Link Icon
Dragging and dropping a document on a link icon activates the application corresponding to each icon.

7. Status Bar
Displays information such as image file name, image type, and size.

8. Image Window
Displays the image and annotations of the pages being selected.

9. Ruler
Displays the actual size of an image that is selected. The unit of measurement is switched by Ruler Unit
in the View menu.
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Basic Operations

• Selecting Page
Selecting a page by clicking in the page list displays an image
of the selected page on the image window.

Dragging and dropping a page in the page list can change the
order of the pages.

• Image Editing
The image displayed in the image window is edited with the
menu below:

- Edit menu 
Editing operations such as cutting, copying, pasting
annotations added to an image.

- Page - Adjust Page menu 
Image correction and color balance adjustment of the whole
page.

• Selecting Area
Dragging the mouse on the image window allows selection of
a specific area in an image. This function is used to save a
specified area or specifying an area for annotation.
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Document Viewer provides the functions for adding various graphics and text to an image. The graphics and
text added to an image are called <Annotation>.

The annotation function, unlike usual image editing applications, does not change an image itself but lays
graphics and texts onto an image. Annotations and the original image are displayed as one image.

Annotations are managed separately from image data. Therefore, the Document Viewer can switch
between displaying and hiding annotations.

If an image is edited with the Document Viewer, and is exported (sent) to another image editing application,
whether to attach the annotation to an image or not can be selected.

Annotation Function

Annotation Original image Annotation added
to the original image
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File Menu
• Open

Opens an image file saved in the computer.
Files of the following formats can be opened on the Document
Viewer.

- TIFF
Tagged-Image File Format (TIFF).

- JPEG 
Joint Photographic Experts Group (JPEG) format.

- BMP 
Windows standard bitmap format.

- PNG
Portable Network Graphics format.

- DDM
Document Manager file format.

• Save
Save a document being edited.

• Save As
A document is saved as an ordinary image file under a specified
name.

- All page(s)
Save all pages in the document.

- Select page
Save only the selected page.

- Specified area
Save only the portion specified in the image window.

Document Viewer saves a file in the following formats:

- TIFF
Tagged-Image File Format (TIFF).

- Multi-page TIFF
Multipages Tagged-Image File Format (TIFF).

- Internet Fax TIFF
Tagged-Image File Format (TIFF) with Internet Fax format.

- JPEG 
Joint Photographic Experts Group (JPEG) format.

- BMP 
Windows standard bitmap format.

- PNG
Portable Network Graphics format.

- PDF
Adobe Acrobat PDF format.

- DDM
Document Manager file format.



Document Viewer

File Menu

D
oc

um
en

t M
an

ag
em

en
t 

Sy
st

em
 S

ec
tio

n

NOTE 1. When saving a document with annotations, save the document in the Document Manager file
format (DDM). This format saves the annotations and image data separately (as objects) so
that they can be edited later. Although saving a document in another format allows further
editing, the annotations cannot be undone. They are merged into the File.

• Print
Prints a document under the editing operation. For a document
containing two or more pages, pages from-to can be specified
for printing.

• Print Setup
Specify the layout, printing size, and printing of annotations for a
document to be printed.

1. Vertical position and horizontal position
Adjust the printing position on a sheet.

2. Print Size
Select printing in original size or printing in accordance with
the sheet size.

3. N in 1 printing
Select for printing two or more reduced pages on one sheet.

• Acquire Image
Adds a new image to a document.  The application selected in
Select Source runs and a scan image is created.

• Select Source
Selects the source for the image added through Acquire Image.
105



Document Viewer

106

File Menu
NOTE 1. See "Setting Plug-in"  (See page 81) for specifying an external application.

• Launch to another application
Opens a document selected in the document window with a
specified application.

Selecting External Application Setup displays a dialog box for
adding/changing/deleting the application.

Clicking the Add button displays a dialog box to Add External
Application.

1. Name
If an external application is specified, the name in this field
appears on a link icon.

2. Application Type
Specify the application type.

3. Program File
Specify the execution file of an application.

4. MAPI Compliant
Check here if the E-mail application is compatible with
MAPI.

5. Parameter
If the E-mail application is incompatible with MAPI, adding
a parameter here allows automatic activation of a
transmission screen.
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• Trash Can
- Open Trash Can

Opens the Trash Can and displays any pages. Selecting page

and clicking the  button restores page that has
been discarded.

- Empty Trash Can
Deletes the pages in the Trash Can. If the page is emptied from
the Trash Can, it is permanently deleted and does not stored in
the Windows Recycle Bin.

Undo
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Edit Menu

• Undo
Undo the last editing operation done.

• Cut
Delete a selected annotation from a folder and
copy it to the clipboard.

• Copy
Copy a selected annotation onto the clipboard.

• Paste
Paste an annotation from the clipboard onto a
selected page.

• Clear
Clear a selected annotation.

• Select All
Select all annotations onto a selected page.
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• Drag Mode
Changes from Drag Mode to Text Edit Mode.

• Zoom In
Zooms in an image.

• Zoom Out
Zooms out an image.

• Fits to Page Width
Fits the display to the page width.

• Fits to Page Height
Fits the display to the page height.

• Full Page
Fits the display to the page full size.

• Original Size
Returns the display to the original size.

• 25% - 200%
Shows the display at 25% - 200%.

• Detailed Settings
Sets detailed settings such as thumbnail or page image setting.

View Menu
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Page Menu

• Next
Display the next page.

• Previous
Display the previous page.

• Top
Display the top page.

• Last
Display the last page.

• Select
Display a specified page.

• Auto Paging
Turns the pages automatically.
- Move Forward

Automatically step through pages forwards.
- Move Backward

Automatically step through pages backwards.
- Stop

Stop automatic page advance.
- Set up 

Set automatic page advance.

• Move page
Moves pages to the desired position.
- Next page

Move the current page to be posterior to the next page.
- Previous page

Move the current page to be anterior to the previous page.
- Top page

Move the current page to be the top page.
- Last page

Move the current page to be the last page.
- Select page

Move the current page to the page you specified.

• Delete Page
Deletes the current page.

• Copy Page
Copy the current page.
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NOTE 1. Grayscale and color information of a grayscale or RGB color image is lost upon conversion into
a monochrome image. The lost information is not restorable.

2. Color information of a RGB color image is lost upon conversion into a grayscale image. The
lost information is not restorable.

• Add Page
Adds new pages to documents.

• Insert Page
Inserts a page at the current position.

• Replace Page
Replace the current page with a new one.

• Rotate Page
- Rotate Right

Rotate the page 90 degrees clockwise.
- Rotate 180 Degrees

Rotate the page 180 degrees
- Rotate Left

Rotate the page 90 degrees counterclockwise.

• Adjust Page
- Correct Skew

Adjusting orientation.
- Eliminate Noise

Eliminate the noise.
- Enhance Edge

Enhances the edge.
- Brightness/Contrast

Adjusts brightness or contrast.
- Hue/Chroma

Adjusts hue or chroma.
- Reverse Gradation

Reverse Gradation.
- Monochrome

Convert to Monochrome.
- Grayscale

Converting to Grayscale.
- RGB

Converting to RGB full color.
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Page Menu
• Copy Page to Clipboard
Copy the entire page selected onto the clipboard.

• Copy Select Area
Copy Select Area To Clipboard

• Select All Pages
Select All Pages.
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Annotation Menu

• Show Annotation
The check box on/off setting specifies whether to display an
annotation in the page list thumbnail.

• Set Annotation
Protect the annotation from re-editing.

• Annotation Order
- Change Order To Top
- Change Order To Last
- Change Order To Previous
- Change Order To Next

• Text
Creates a text annotation and paste it to a page.

• Line
Creates a line annotation and paste it to a page.

• Rectangle
Creates a rectangular annotation and paste it to a page.

• Ellipse
Creates an ellipse annotation and paste it to a page.

• White Block
Creates a white rectangular (solidly white-painted rectangle)
annotation and paste it to a page.

• Black Block
Creates a black rectangular (solidly black-painted rectangle)
annotation and paste it to a page.

• Marker
Create a marker annotation and paste it to a page.

• Label
Creates a label annotation and paste it to a page.

• Stamp
Creates a stamp annotation and paste it to a page.

• Date
Creates a date annotation and paste it to a page.

• Page No.
Creates a page number annotation and paste it to a page.
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Annotation Menu
NOTE 1. For specifying text font and colors, select the drawn text and select Properties in the
Annotation menu  (See page 113). The Text Format Setup dialog box can be displayed also
by selecting Properties in the pop-up menu, that appears by right-clicking on a drawn text.

2. For specifying the thickness and color of a line, select a drawn line and then select Properties
in the Annotation menu  (See page 113). Graphics Format Setup dialog box can be displayed
also by selecting Properties in the pop-up menu, that appears by right-clicking on a drawn
line.

• Header
Edits a header common to each page.

• Footer
Edits a footer common to each page.

• Edit Text
Sets a format of a text in a selected annotation.

• Properties
Display Properties for annotation.
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• Text
Creates a text annotation. Select text annotation in annotation
menu (or tool button), and drag the mouse in the image
window to specify the display position.
A dialog box for text setup will appear.
Enter the text to display, and then specify text color and font.

• Line
Creates a line annotation.
Select line annotation in the annotation menu (or tool button),
and drag the mouse in the image window to draw lines.

• Rectangle
Creates a rectangle annotation.
Select rectangle annotation in the annotation menu (or tool
button), and drag the mouse in the image window to draw a
rectangle.
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Annotation Menu
NOTE 1. For specifying the thickness and colors of the rectangle, select the drawn rectangle and select
Properties in the Annotation menu  (See page 113). The Graphic Format Setup dialog box
can be displayed also by selecting Properties in the pop-up menu, that appears by right-
clicking on a drawn figure.

2. For specifying the thickness and colors of the ellipse, select the drawn ellipse and select
Properties in the Annotation menu  (See page 113). The Graphic Format Setup dialog box
can be displayed also by selecting Properties in the pop-up menu, that appears by right-
clicking on a drawn figure.

• Ellipse
Creates an ellipse annotation.
Select the ellipse annotation in the annotation menu (or tool
button), and drag the mouse in the image window to draw an
ellipse.
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NOTE 1. For specifying lines and colors of solid white, select the drawn solid white rectangle and select
Properties in the Annotation menu  (See page 113). The Graphic Format Setup dialog box
can be displayed also by selecting Properties in the pop-up menu, that appears by right-
clicking on a drawn figure.

2. For specifying lines and colors of solid black, select the drawn solid black rectangle and select
Properties in Annotation menu  (See page 113). The Graphic Format Setup dialog box can
be displayed also by selecting Properties in the pop-up menu, that appears by right-clicking
on a drawn figure.

• White Block
Creates a white rectangle (solidly white-painted rectangle)
annotation.
Select the white annotation in the annotation menu (or tool
button), and drag the mouse in the image window to draw a
white rectangle.

• Black Block
Creates a black rectangle (solidly black-painted rectangle)
annotation.
Select the black annotation in the annotation menu (or tool
button), and drag the mouse in the image window to draw a
black rectangle.
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Annotation Menu
NOTE 1. For specifying the color of a marker, select the drawn marker and select Properties in the
Annotation menu  (See page 113). The Graphic Format Setup dialog box can be displayed
also by selecting Properties in the pop-up menu, that appears by right-clicking

2. For specifying the color and font of a label, select the drawn label and select Properties in the
Annotation menu  (See page 113). The Graphic Format Setup dialog box can be displayed
also by selecting Properties in the pop-up menu, that appears by right-clicking on a drawn
label.

• Marker
Creates a marker annotation.
Select the marker annotation in the annotation menu (or tool
button), and drag the mouse in the image window to draw a
marker.

• Label
Creates a label annotation.
Select the label annotation in the annotation menu (or tool
button), and drag the mouse in the image window to draw
label displays Text Format Setup dialog box.
Enter texts to display and specify text color and font.
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• Stamp
Creates a stamp annotation.
The stamp annotation pastes another image file like a stamp.
Select the stamp annotation in the annotation menu (or tool

button) and click the  button. Then drag the
mouse in the image window to specify the area, displaying the
stamp dialog box.

Click the  button to specify an image from a file.

Clicking the  button allows selecting image files to
be used as a stamp.

OK

Browse

Add
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Annotation Menu
NOTE 1. For specifying the color or font of the date, select the drawn date and select Properties in the
Annotation menu  (See page 113). The Text Format Setup dialog box can be displayed also
by selecting Properties in the pop-up menu, that appears by right-clicking on a drawn figure.

• Date
Creates a date annotation.
Select the date annotation in the annotation menu (or tool
button), and drag the mouse in the image window to specify
the area, displaying the Properties dialog box.
Specify the format, color, and font of the date to be displayed.

1. Font Name
Specify the font here.

2. Style
Specify the font style.

3. Size
Specify the font size.

4. Text Color
Select the text color here.

5. Date
Specify the date here. Selecting from the calendar or
entering the date is selectable for data entry.

6. Format
Specify the display format here.

7. Text Align
Specify the text alignment.
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• Page No.
Creates a page number annotation.
Select the page number annotation in the annotation menu
(or tool button), and drag the mouse in the image window to
specify the area. Double-click the Page No area to display the
text the settings dialog box.
Specify format, color, and font of the page number to be
displayed.

1. Font Name
Specify the font here.

2. Style
Specify the font style.

3. Size
Specify the font size.

4. Text Color
Select the text color here.

5. Text Align
Specify the text alignment.

Opens the Graphics Format Setup Dialog box.
Click on the drawn figure and select Properties to change the
thickness and colors of the lines.

1. Line Width
Specify the thickness of the lines here.

2. Line Style
Specify the types of lines here

3. Line Color
Specify the color of the lines here.

4. Fill Color
Select the color for solid painting here.
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• Main Tool Bar
Show/hide main toolbar.

• Page Tool Bar
Show/hide page toolbar.

• Annotation Tool Bar
Show/hide page adjustment toolbar.

• Image Tool Bar
Show/hide page adjustment toolbar.

• Status Bar
Show/hide statusbar.

• Page List
Show/hide page list.

• Ruler
Show/hide ruler.

• Plugin
Show/hide plug-in.

Window Menu
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Status Monitor

The Status Monitor is a MFP utility that monitors and displays the current status of connected devices.
Upon activation of Windows, the icon of the status monitor appears on the System Tray.

The Status Monitor indicates the device status by icon lamp color as listed below.

NOTE

1. If the power of the device is not turned on or the parallel cable is not connected when starting
Windows, the error message shown above appears.

Verify the power source and parallel cable and then press the  button.
2. Connecting the device to a network server disables the status monitor.
3. UF-890/990 is not available with this feature.

Task Bar Display

Lamp color Status
Blue Device is operational under standby, printing, copying status.

Yellow Device inspection is required under initialization, paper supply, open cover,
paper jam, etc.

Red Need for toner cartridge replacement, or device failure.

Gray Device is in Engergy Saver (Sleep) Mode.

Status Monitor

Retry
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Right-clicking on the status monitor in the System Tray displays the dropdown menu as shown below:

1. About
Displays the version information about the status monitor.

2. Open Status Monitor
Displays details about the current status of the device.

3. Pop up when error occurs
Selects whether or not a pop-up error message box appears when an error occurs on the connected
device.

When selected, a check mark appears to the left of the item. To turn off the pop-up error message, select
the item again and the check mark disappears.

< Example of a pop-up error message box >

4. Exit
Close the status monitor.

Task Bar Menu
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Right-clicking the status monitor icon in the Task Bar and selecting Open Status Monitor in the dropdown
menu displays a dialog box for the status monitor.

• Status Tab

1. Model
Displays the name and number of a connected device.

2. Device Status
Displays the current status of the device.
If two or more items have been detected, clicking  /  buttons allows viewing all items.

3. Control Panel Display
Displays information as appear on the panel of the device.
If two or more items have been detected, clicking  /  buttons allows viewing all items.

4. Details
Displays the current status of the device in details.
If two or more items have been detected, clicking  /  keys allows viewing all items.

5. Status
Displays the communication status between the status monitor and the device.

Display Status Details
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Display Status Details

• Configuration Tab

1. Model
Displays the name and number of a connected device.

2. Configuration
Display a list with the current device configuration (optional devices, etc.).

3. Status
Displays the communication status between the status monitor and the device.
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• Paper Tab

The tab displays the type, size, and if there is any paper loaded in the paper tray. A comment by the user
can be entered freely in the <Paper Type> field.

NOTE 1. Changing the types of loaded paper does not change the comment in <Paper Type> unless it
is rewritten by a user.
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Configuration Editor

This utility allows you to edit the machine configuration through the Parallel Port connected between the PC
and the device.

Startup Windows, and select Panasonic → Panasonic Document Management System → MFP
Utilities → Configuration Editor from the Programs in the Start menu to display the configuration editor
dialog box.

Each setting category appears as a folder on the left frame and the setting item appears on the right frame.

Main Window

If the device is turned "Off" or not connected, a dialog box
appears as below. You may select.

• Retry 
After turned "On" the power or connected the device.

• Work Off-Line
Edit the data from an existing file.

• Exit
Exit the program.

When there is more than 1 supported model series installed,
a "Browse for Folder" dialog box appears as below.

• Select the model series folder and click OK.



Configuration Editor

Main Window

D
oc

um
en

t M
an

ag
em

en
t 

Sy
st

em
 S

ec
tio

n

•  button
Retrieve the current settings of the selected folder from the device.

•  button
Write's the settings in the folder to the device.

•  button
Opens the settings in the folder from a file.

•  button
Saves the settings in the folder to a file.

•  and  buttons
Switch between pages if the settings have two or more pages.

•  button
Displays the help screen.

•  button
Displays version information.

•  button
Close the Configuration Edit utility. If the data has not been sent after being modified on the screen, a
confirmation message for sending the data is displayed.

NOTE 1. Only settings in the setting folder that are currently selected are applicable to retrieving/writing
on the device, or retrieving/writing of a file.

2. Current settings of each folder are read from the device by double-clicking a folder in the left of
the dialog box.

3. The setting menu's are different depending on the machine to be used with this MFP utility.
4. UF-890/990 is not available with this feature.

RetrieveRetrieve

Write

Open File

Save File

Help

About...

Exit
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Specify the originating party name and telephone number, etc. to be registered on the device for fax
communications.

User Parameters Folder
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Display or change the Fax Parameter Settings.

NOTE 1. The contents of the Fax Parameter differs depending on the model.

Fax Parameters Folder
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Display or change the General Functions.

General Functions Folder
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Display or change the Copier Settings.

Copier Setting Folder
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Display the Fax communication journal.

Journal Folder
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When the Phonebook Folder is selected the Phone Book Editor utility will be started.

Phonebook Setting Shortcut Activation Folder
135
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Phonebook Editor

This function allows registering, deleting, and modifying fax phone numbers in the main unit from a
connected PC.

Features provided by the Phonebook Editor function are as follows:

NOTE 1. UF-890/990 is not available with this feature.

Features

Registering, deleting, modifying
fax numbers can be operated on
the control panel of the machine.

The operation described on the
left is controllable on a connected
PC.

Retrieve/Write Retrieve fax numbers in main unit to the PC, or send fax
numbers from the PC to the main unit.

Page 141

Open/Save File Open or save fax numbers stored the PC. Page 143
Insert/Delete Entry Insert or delete lines in the fax number list. Page 145

Page 146

If the device is turned "Off" or not connected, a dialog
box appears as below. You may select.

• Retry 
After turned "On" the power or connected the
device.

• Work Off-Line
Edit the data from an existing file.

• Exit
Exit the program.

When there is more than 1 supported model series
installed, a "Browse for Folder" dialog box appears as
below.

• Select the model series folder and click OK.
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Take the following steps to activate the phonebook editor software.

Activation Procedure

 Click Start at the bottom left of the PC screen.

Select Programs.

Select Panasonic.

Select Panasonic Document Management       
System.
Select MFP Utilities.

Select Phone Book Editor.

Phone Book Editor splash screen appears and the 
Phone Book Editor program is activated.

Start

1

2

3

4

5

6

7
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The screen shown below appears on the PC:

Main Window (For DP-2500/3000)

No. Indication Description Reference
Station Name Station name (Up to 200 stations with 15 characters each) -

Key Name Key name (Up to 10 characters) -

Telephone No. Telephone number (Up to 36 digits) -

About Version information of software -

Retrieve Retrieve phonebook information from the connected Page device. Page 141

Write Send phonebook information to main unit Page 143

Open File Read phonebook information in PC Page 143

Save File File Save phonebook information onto PC Page 143

Insert Entry Insert a blank entry in the phonebook list Page 145

Delete Entry Delete an entry in the phonebook list Page 146

Help Display help screen
• When an explanation about the operation is needed.

-

Exit Close the phonebook editor software -

1

2

3

4

5

6

7

8

9

10

11

12
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The screen shown below appears on the PC:

Main Window (For DP-135/150/1810/2000/2010)

No. Indication Description Reference
Abbr. Dialing No. Tab Contains the abbreviated dialing number entries -

One-Touch Tab Contains the One-Touch Key entries -

About Version information of software -

ABBR. NO. Abbreviated Dialing Number -

Telephone No. Telephone number (Up to 36 digits) -

Station Name Station name (Up to 15 characters) -

Retrieve Retrieve phonebook information from the connected Page device. Page 141

Write Send phonebook information to main unit Page 141

Open File Read phonebook information in PC Page 143

Save File File Save phonebook information onto PC Page 143

13 14
15

1

2

3

4

5

6

7

8

9

10
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Main Window (For DP-135/150/1810/2000/2010)
Insert Entry Insert a blank entry in the phonebook list Page 145

Delete Entry Delete an entry in the phonebook list Page 146

Help Display an on-line help screen -

Exit Close the phonebook editor software -

ONE-TOUCH One-Touch Key -

No. Indication Description Reference

11

12

13

14

15
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This function retrieves the fax numbers in the connected device by PC and writes fax numbers from the PC
to main unit.

Retrieve/Write

1 Click Retrieve.

2 Click the  button.

3 A list of fax numbers in the machine is
displayed.

Modify and add destination names and dial
numbers on this screen.

4 Click Write after the editing is completed.

Retrieve

Yes

Write

Continued on the next page...
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Retrieve/Write
5 Click the  button.

The phonebook information is written to the
connected device.

Yes
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This function opens the phonebook file stored in the PC, edits the file and then saves the file in the PC
again.

Open/Save File

1 Click Open File

2 Click the  button.

3 The File Open dialog box appears
1. Select a file from the list.
2. Click the  button.

4 The phonebook information stored in the PC
is displayed.

Modify and add destination names and dial
numbers on this screen.

Open File

Yes

Open

Continued on the next page...
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Open/Save File
5 Click Save File after the editing is completed.

6 Click the  button.

The phonebook information is saved in the
PC.

7 For Save File:
1. Select an existing file from the list or

enter a new file name.

2. Click the  button.

Save File

Yes

Save
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This function adds lines in the list when editing the phonebook.
The steps for inserting lines is as follows:

Insert Entry

1 Ex: Insert a line between the 2nd and 3rd lines.
Click the portion indicated as .

2  Click Insert Entry.

A line is inserted as shown on the left.

3 Double-click on the line for data entry.

1

2

145
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The steps for deleting lines is as follows:

Delete Entry

1 Ex: Delete the 3rd line.
Click the portion indicated as .

2 Click Delete Entry.

The screen shown on the left appears.

Click  .

The line is deleted as shown on the left.

1

OK
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Panafax Desktop

Panafax Desktop is a PC Faxing application specifically designed to compliment the Panasonic line of multi-
function products. 

Document created on the PC can be easily faxed to a remote location directly without having to print a hard
copy first and then put through the fax machine to send. This improves the copy quality received at the
remote location and saving the cost and time of printing the hard copy locally before faxing it.

Note: DP-135/150/1810P/2000/2010E/2500/3000 is not available with this feature.

Sending a Document via Windows Application
You can send a fax directly from any Windows Application by simply printing to the Panafax Desktop
Driver.

For example, compose a document from your word processor application. When you are finished and ready
to fax it to a remote location, simply follow the procedures below.

General Description

Sending Document

1 From the current Application select Print from
the File menu.

2 The Print dialog box appears.

Select Panafax Desktop Driver from the
Printer Name menu.

Click on the  button to convert the

document into a Fax image.

OK

Continued on the next page...
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Sending Document
3 The Panafax Desktop window appears with
the Fax image attached.

To preview the Fax image, click on the
Preview button on the tool bar at the left of the
window.

Click on the  button to return to

the Panafax Desktop window.

4 From the Panafax Desktop window, enter the
recipient's Fax No. , Name and Company or
select from your Personal Address Book.

Click the  button to register the recipient
to the recipient list.

Enter/select another recipient if desire.

Type a subject in the Subject field and a brief
message to be included in the Cover Page.

Close
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5
Click on  the   (Send) button when

ready to send the fax.

6 Click on the  button to start the

transmission.

OK
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Sending Document

Sending a Document to a recipient in the Personal Address Book

The frequently used fax numbers can be registered tn the Panafax Desktop Personal Address Book. 

To register a recipient to the Personal Address Book, see page 152.

1 From the Panafax Desktop main window.

Click on the  (Open File) button to

select a file for the transmission.

Note: You may also attach the file by printing
to the Panafax Desktop Driver from any
Windows application as described on
page 147.

2 Select the file and click the 

button.

3 The Panafax Desktop window appears with
the Fax image attached.

To preview the Fax image, click on the
Preview button on the tool bar at the left of the
window.

Click on the  button to return to

the Panafax Desktop window.

Open

Close
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4 Click on the Personal Address Book tab and
select the recipient(s) from the list.

Clock on the  button to register the
recipient(s) to the recipient list.

Then, click the   (Send) button.

5 Click on the  button to start the

transmission.

OK
151



Panafax Desktop

152
To register a recipient to the Personal Address Book, follow the steps below:

Managing the Personal Address Book

1 Click on the  (Personal Address Book)

button to open the Phone Book dialog box.

2 Click on the  button.

3 <Contact Tab>
• Name

Enter the recipient's name.

• Fax No.:
Enter the fax number.

• Call Type:
Select how the call should be dialed.

4 <Data Fields Tab>
Enter the Company Name, Department,
Job Title, Address, Direct Phone No. and
the Extension Phone No. of the recipient
to be used on the Cover Sheet.



Panafax Desktop

Managing the Personal Address Book

D
oc

um
en

t M
an

ag
em

en
t 

Sy
st

em
 S

ec
tio

n

NOTE 1. The One-Touch/Abbreviated Dialing Numbers registered in the your machine are automatically
uploaded in the Personal Address Book when activating the Panafax Desktop if the machine is
corrected to your PC.

5 Click on the  button to save the

entry.

To add another entry, repeat from step 2.

OK
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To register a group of recipients, follow the steps below:

Managing the Personal Address Book

1 Click on the  (Personal Address Book)

button to open the Phone Book dialog box.

2 Click on the   button.

3 The Group Registration dialog box appears.

Click on the  button.
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4 The Add New Group Name dialog appears.

Enter the group name and click 

button.

5 Select the desired recipients.

6 Click the  button to add the

recipient(s) to the Member list.

To add another group, repeat from step 3.

If finished, click the  button to exit

Group Registration.

OK

OK
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If you have set the Fax Parameter No. 63 (PC-FAX RCV Mode) on your machine to “Upload & Print” or
”Upload”, the received faxes is automatically uploaded to the Panafax Desktop.

NOTE 1. Make sure that the Port Controller is activated when receving a fax. Otherwise, the received
fax cannot be uploaded to your PC even if the Fax Parameter No. 63 is set to "Upload & Print"
or "Upload".

Receiving Document

When a fax is receive on the machine, it will proceed as follow:

1 A receiving notice appears on the connected PC.

Click the  button.

2 The Receive Log appears.
Select a transaction from the log then click the

 (View Faxes) button to view the received fax.

3 The received fax is shown on the PC.

Receiving LOG
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The Cover Sheet is attached to the first page of every sending fax and contains information such as the
recipient's name, sender's name, date, title, etc.

Creating a Cover Sheet

Cover Sheet

1 Click on  the   (Cover Sheet Editor)

button.

2 The Cover Sheet Editor window appears. 

[Edit] menu

Page Size Sets the size of the cover sheet.

Date Frame Inserts a date field.

Text Frame Inserts a text box.

Line/Box Inserts a line or box.

Image Frame Inserts an existing image file (bmp file).

Recipient Details Inserts the information set in the  and  tabs on the Personal
Address Book.

Sender Details Inserts the information set in the  tab on the Setup menu.

Comment Inserts a comment field for typing a brief message when sending a fax.

Subject Inserts a subject field when sending a fax.

Data Fields Personal

Sender Details
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Cover Sheet

[View] menu
Show Grid Display the grid.

Preview Display the preview of the cover sheet.

Show Status Bar Display the status bar.

Zoom Sets the ratio for the cover sheet editing screen.

Scale unit Sets the scale unit of measure (cm/inch).

[Options] menu

Font Specifies the character font.

Line Style Specifies the line style.

Text Alignment Adjusts the text position.

Date Format Sets the date format.
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Setting the Usage of the Cover Sheet

1 Click on the   (Configuration) button.

2 The Options dialog box appears.

Show the  tab. 

3 Select the Cover Sheet then set the usage.

Click on the  button.

Cover Sheet

Apply
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Panafax Desktop main dialog box.

Tool Bar

 [Send] Used to start the transmission.

 [Preview] Used to view the cover sheet or transmission file.

 [Configuration]
Used to specify the resolution and paper size for the transmission. Also, used
to set the Cover sheet usage.

 [Open] Used to select the file to be send.

 [Personal Address Book] Used to open your personal address book.

 [Setup] Used to specify the Send Settings, Sender Details and Connection Settings.

 [Cover Sheet Editor] Used to create or edit a Cover Sheet.

 [Send/Receive Log] Used to show the Send/Receive Log Manager.

 [Help] Used to show the On-line help.
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Dialing Settings Tab
Specify the local and long distance call access number and whether or not to apply it when dialing.

Sender Details Tab
Used to identify yourself with various information on the Cover Sheet when sending a fax.

Setup Menu
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Setup Menu

Connection Tab

Specifies the connection type and directory/folder path of the following components.

• Scheduler
• Send Log
• Receive Log

For details on setting up Client and Server connection, please refer to the section of Client and Server
Setting on page 165.

PIN Code Tab
Specify the PIN Code settings when required by your telephone system.
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Page Size Tab
Set the page size to be used for the transmission. The selectable page sizes are depending on the
capability of the machine connected to your PC.

Quality Tab
Set the quality to be used for the transmission.

Configuration Menu
163



Panafax Desktop

164

Configuration Menu

Others Tab

Set the other preferences.
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The Panafax Desktop module can be setup on any Windows computer on a network to serve as a Fax
Server with a compatible Panasonic MFP Fax/Copier connected. Other computer on the network with the
Panafax Desktop module installed and setup as Client can then send and receive faxes through the
Panafax Desktop Server PC. All received faxes are stored on the Panafax Desktop Server PC, and
retrieved on the Client PC by accessing and viewing the shared Receive Log.

Setting the Panafax Desktop as a Server

NOTE 1. UF-490 for North America supports standalone connection only.

Client and Server Setting

1 Install the Panafax Desktop module of the Panasonic-DMS on a networked
computer to be designated as the Fax Server.

2 Double-click the Panafax Desktop shortcut icon on the Windows Desktop.

3 The Panafax Desktop window appears.

4 From the Menu bar, select Tools then Setup...

5 The Setup dialog box appears.

6 Select the Connection tab.

7 Change the Connection setting to Server and click .

8 Start the Windows Explorer, locate the following folders and set them as a shared
folder.

• C:\Program Files\Panasonic\Panasonic-DMS\Port Controller (Set the Share Name 
as SCHEDULER)

• C:\Program Files\Panasonic\Panasonic-DMS\Panafax Desktop\Send (Set the Share 
Name as SEND_FOLDER)

• C:\Program Files\Panasonic\Panasonic-DMS\Panafax Desktop\Receive (Set the 
Share Name as RCV_FOLDER)

Update
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Client and Server Setting

Setting the Panafax Desktop as a Client

1 Install the Panasonic-DMS on a networked computer and select Client install on the
Select Setup Type dialog box during the installation.

2 Click  to copy all the necessary files.

3 Click  and restart the computer.

4 After the computer has restarted, double-click the Panafax Desktop shortcut icon on
the Windows Desktop.

5 The Panafax Desktop window appears.

6 From the Menu bar, select Tools then Setup...

7 The Setup dialog box appears.

8 Select the Connection tab.

9 Verify the Connection setting is set to Client.

10 Set the Directory/Folder Path to the Panafax Desktop Server of the following
components

• Scheduler (Mfpscdl.exe)
• Send Log (SndLogList.mdb)
• Receive Log (RcvLogList.mdb)

Next

Finish
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Troubleshooting

Troubleshooting

If the printing operation fails, check the following points first:

• The connection cable (Parallel Printer Cable or Ethernet LAN Cable) is properly connected.
• The length of the parallel printer cable is not longer than 20 ft. (6 m).
• Power of the device is turned ON.
• Paper is loaded properly on the device.
• Error message is not displayed on the device.

The above points can be verified by printing a test page. Refer to the following for procedures for test page
printing:

NOTE 1. The status of the devices can be verified by the status monitor  (See page 123).

Printing operation fails

Windows 95/98/Me [General Tab]  (See page 30)

Windows NT 4.0 [General Tab]  (See page 40)

Windows 2000/XP [General Tab]  (See page 54)
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Document is not printed correctly

Problem Action
Printing position is wrong or print is
misses on the edge.

Paper size or printing orientation is different between the application settings and
the printer driver settings. Specify the settings again.
The specified paper has not been loaded on the device.
Specify the settings again or load the appropriate paper.
The document margin is not sufficient. On the machine, a margin of approx. 5 mm
or more is required at the sheet edge.
(Recommended printing margin) Adjust the margin correctly.

Characters and symbols not used in
documents are printed.

Verify that your machine has been selected as the printer driver.

Printing operation takes excessive
time.

The wait time for printing operations depends on the spool settings.
Select Spool print jobs so program finishes printing faster in spool settings.

• Reference :
Windows 95/98/Me [Details Tab]  (See page 31)
Windows NT 4.0 [Scheduling Tab]  (See page 42)
Windows 2000/XP [Advanced Tab]  (See page 57)
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Error messages displayed on the computer

Problem Action
Error in writing to LPT1.
Unable to write to the Specified
device.

Verify that the device is connected to the computer correctly.
Verify that the power of the device is turned on.
Verify that the paper is properly loaded.

Error in writing to LPT1.
Printer timeout error occurred.

Verify that the power of the device is turned on.
Excessive data volume or number of pages may overflow the device's memory,
disabling data reception.
Increase the timeout setting value in properties (for transmission retry).

• Reference :
Windows 95/98/Me [Details Tab]  (See page 31)
Windows NT 4.0 [Ports Tab]  (See page 41)
Windows 2000/XP [Ports Tab]  (See page 56)

Printing is disabled due to an error in
the current printer settings.

Differences in settings such as paper size or printing orientation exists between the
application and the printer driver.
Specify the correct settings.
169
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Printing/Scanning Area

Top

0.1/2.5

0.1/2.5

0.1/2.5

Bottom (Unit: inches/mm)
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The printer has a parallel interface for connecting to the PC.

Shape of Connector

Signal lines and pin assignment

*Signal used for bidirectional communication

Signal functions

Parallel Interface Connector

No. I/O Signal name No. I/O Signal name 
1 I STB 19 - GND

2 I/O DATA0 20 - GND

3 I/O DATA1 21 - GND

4 I/O DATA2 22 - GND

5 I/O DATA3 23 - GND

6 I/O DATA4 24 - GND

7 I/O DATA5 25 - GND

8 I/O DATA6 26 - GND

9 I/O DATA7 27 - GND

10 O nACK 28 - GND

11 O BUSY 29 - GND

12 O PE 30 - GND

13 I SELECT 31 I nNIT

14 O nAUTOFD* 32 O nFAULT

15 - Not Used 33 - Not Used

16 - GND 34 - Not Used

17 - GND 35 - Not Used

18 O PLH 36 I nSELIN*

Signal name Function
STB Signal for sending data to printer.

Steady-state value is High. 
Printer reads data until this signal becomes from Low to High.

DATA0 to DATA7 Input signal for receiving 8-bit data.
Logic 1 is High. 
DATA0 is LSB and DATA7 is MSB.

nACK Signal indicating that printer has read data into device completely.
This signal is output in response to /STB.

18 1

36 19
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Parallel Interface Connector
BUSY Signal indicating that printer is unable to receive data.
Printer is able to receive data when this signal is Low.

PE Signal indicating Paper Out of printer.
This signal is Low when paper is loaded and is High when paper is out.

SELECT Signal indicating that printer is under online status.
Printer is capable ofreceiving data when this signal is High.

nAUTFD Signal used for bi-directional communication.

GND Ground

VCC Signal indicating that the power of printer is on.
This signal allows verifying ON/OFF status of power of printer and connection status of
printer cable.

nINT Signal for initializing printer.
Steady-state value is High.
Printer is initialized by Low.

nFAULT Signal indicating that printer is faulty.

nSELIN Signal used for bi-directional communication.

Signal name Function
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Class 2 Fax Modem Section

Installing the Panasonic Class 2 Fax Modem

The installation is required for transmitting/receiving of Faxes with a PC using general-purpose PC fax
function software (recommended: WinFax PRO 10.0).

Class 2 Fax Modem

Installation (Windows 95/98/Me)

1 Install the Com Port Redirector component from
the Panasonic-DMS installation using the
Custom install if you haven't installed the PDMS
software.

2 Select Settings from the Start menu and open the
Control Panel.

Double-click the Add New Hardware icon.

3 Click on the  button.Next

Continued on the next page...
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Installation (Windows 95/98/Me)
4

(Windows 98/Me only)

Click on the  button.

5

(Windows 98/Me only)

1. Select No, the device isn't in the list.
2. Click on the  button.

(This screen will only appear if a new device is
found.)

3. Select No, I want to select the hardware from
a list.

4. Click on the  button.

6 1. Select Ports (COM&LPT).
2. Click on the  button.

Next

Next

Next

Next
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7 1. Select Communications Port.
2. Click on the button.

8 1. Enter D:\English\PanaDMS\Setup.
(Where "D" is your CD-ROM drive.)

2. Click on the  button.

9 Click on the  button.

10 Click on the  button.

Have Disk...

OK

Next

Next

Continued on the next page...
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Installation (Windows 95/98/Me)
11 Click on the  button.

12 Click on the  button and restart the PC.

13 Repeat steps from "1" to "3."

14

(Windows 98/Me only)

1. Select No, the device isn't in the list.
2. Click on the  button.

(This screen will only appear if a new device is
found.)

3. Select No, I want to select the hardware from
a list.

4. Click on the  button.

Finish

Yes

Next

Next
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15 1. Select Modem.
2. Click on the  button.

16 1. Select Don't detect my modem; I will select it
from a list.

2. Click on the  button.

1. Click on the button.

17 1. Enter D:\English\Pdms\Setup.
(Where "D" is your CD-ROM drive.)

2. Click on the  button.

Next

Next

Have Disk...

OK

Continued on the next page...
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Installation (Windows 95/98/Me)
18 1. Select the Class 2 Fax Modem of your
machine.

2. Click on the  button.

19 1. Select Panasonic MFP Redirected Com Port
(COM3*).
* COM number depends on the PC.

2. Click on the  button.

20 Click on the  button.

• Installation of the modem is completed.

Next

Next

Finish
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Installing the Panasonic Class 2 Fax Modem. The installation is required for transmitting/receiving Faxes
with a PC, using general-purpose PC fax function software (recommended: WinFax PRO 10.0).

Class 2 Fax Modem

Installation (Windows NT 4.0)

1 Install the Com Port Redirector component from
the Panasonic-DMS installation using the Custom
install if you haven't installed the PDMS software.

2 Select Settings from the Start menu and open the
Control Panel.

3 Double-click Modems icon.

4 1. Select Don't detect my modem; I will select
it from a list.

2. Click on the  button.Next

Continued on the next page...
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Installation (Windows NT 4.0)
5 Click on the button.

6 1. Enter D:\English\PanaDMS\Setup.
(Where "D" is your CD-ROM drive.)

2. Click on the  button.

7 1. Select the Class 2 Fax Modem of your
machine.

2. Click on the  button.

8 1. Select the COM port shown at the bottom of
the COM ports list.

2. Click on the  button.

Have Disk...

OK

Next

Next



Installing the Panasonic Class 2 Fax Modem

Installation (Windows NT 4.0)

ss
 2

 F
ax

 M
od

em
 

Se
ct

io
n

9 Click on the  button.

• Installation of the modem is completed.

10 Close the Modems Properties screen.

Finish
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Installing the Panasonic Class 2 Fax Modem. The installation is required for transmitting/receiving FAX's
with a PC, using a general-purpose PC fax function software (recommended: WinFax PRO 10.0).

Class 2 Fax Modem

Installation (Windows 2000/XP)

1 Install the Com Port Redirector component from
the Panasonic-DMS installation using the
Custom install if you haven't installed the PDMS
software.

2 Select Settings from the Start menu and open
the Control Panel.

3 Double-click the Add/Remove Hardware icon.

4 Click on the  button.Next
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5 1. Select Add/Troubleshoot a device.
2. Click on the  button.

6 1. Select Add a new device.
2. Click on the  button.

7 1. Select No, I want to select the hardware from
a list.

2. Click on the  button.

Next

Next

Next

Continued on the next page...
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Installation (Windows 2000/XP)
8 1. Select Modems.
2. Click on the  button.

9 1. Select Don't detect my modem; I will select it
from a list.

2. Click on the  button.

10 Click on the button.

11 1. Enter D:\English\PanaDMS\Setup.
(Where "D" is your CD-ROM drive.)

2. Click on the  button.

Next

Next

Have Disk...

OK
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12 1. Select the Class 2 Fax Modem of your
machine.

2. Click on the  button.

13 1. Select the COM port shown at the bottom of the
COM ports list.

2. Click on the  button.

14 1. If a warning message for logo certification
appears, click on the  button and
continue installation.

2. Click on the  button.
• Installation of the modem is completed.

Next

Next

Yes

Finish

Continued on the next page...
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